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Save Time, No More RETYPING!

Congratulations on acquiring Readiris. This software package will undoubt-
edly be of great help in recapturing your texts, tables, graphics, business cards,
bar codes and even handwritten text!

As efficient as computers are, you have to key in your information first. If you
have ever retyped a 15 page report or a large table of figures, you know how
tedious and time-consuming it can be. Use this state-of-the-art OCR package to
automatically enter text in your applications and you’ll acquire an unprecedented
level of efficiency and comfort!

Scan a printed or typed document, indicate the zones of interest - or have the
system detect them for you - and execute the character recognition. Documents
composed of many pages are processed from start to finish in a single effort. A
few mouse clicks beat long hours of work as Readiris converts your paper docu-
ments into editable computer files: it’s up to 40 times faster than manual retyping.

The wizard guides you through the OCR process comfortably: answer a few
simple questions and you’ll obtain quick and easy results with Readiris. You can
send the reading results directly to your wordprocessor and spreadsheet. To rec-
ognize faxes and convert PDF documents, you can drag the image files from the
Windows Explorer to the Readiris application window. Or right-click on an image
to send it promptly to Readiris.

Readiris recognizes tabular data and recreates them as worksheets or as table
objects inside your wordprocessor; your numeric data are immediately ready for
further processing.

Based on the Connectionist technology from I.R.1.S ., Readiris represents the
best OCR has to offer. Font-independant feature extraction is complemented by
self-learning techniques derived from a proprietary neural network. The system
can learn new characters through context analysis: linguistic knowledge about
syllables and words improves the OCR performance.

Readiris supports up to 117 languages: all American and European languages
are supported, including the Central-European languages, the Baltic languages,



Greek and the Cyrillic (“Russian”) languages. (Optionally, you can read Hebrew
documents and four Asian languages - Japanese, Simplified and Traditional Chi-
nese and Korean.) Readiris even copes with mixed alphabets: the software de-
tects “Western” words that pop up in Greek, Cyrillic, Hebrew and Asian docu-
ments - many untranscrible proper names, brand names etc. are written using the
Western symbols.

Readiris uses linguistics duringthe recognition phase, not after it. As a direct
result, Readiris recognizes documents of all kinds with top accuracy, including
low-quality documents, faxes and dot matrix printouts. It copes beautifully with
badly scanned and copied documents containing too light or dark font shapes.
Joined characters (“ligatures™) are resolved and fragmented forms, such as dot
matrix symbols, are recomposed.

User verification in pop-up style not only flags doubtful characters but also
increases the system’s precision. All solutions confirmed by the user are memo-
rized, increasing speed and confidence as you go along. Using Readiris means
rendering it more intelligent each time! This powerful learning tool allows you to
train Readiris on special characters such as mathematic symbols and dingbats
but also to handle distorted fonts as you will find in real documents.

To increase your productivity further, Readiris not only recognizes your texts,
but can format them for you as well! Make use of “autoformatting” and Readiris
recreates a facsimile copy of the scanned document: the word, paragraph and
page formatting of the original document are retained.

Similar typefaces are used, the point sizes and typestyles as used in the source
document are maintained across the recognition. The placement of columns, text
blocks and graphics follows your original documents. Readiris can even include
the background photo of a scanned page in the recognized document! And as
Readiris supports greyscale and color scanning effortlessly, you can recapture
any graphics - be they lineart, black-and-white photos or color illustrations. When
a document contains tables, Readiris reorganizes them in real cells and recreates
the cell borders of the original tables.
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In other words, Readiris allows you to archive a true copy of your documents,
be it editable and compact text files instead of scanned images! Various levels of
formatting are available, the choice is up to the user.

Bar codes that occur on a scanned page can also be read, and the same goes
for handwritten text - such text can be captured as long as you write well-spaced
“block letters™.

You can even recognize business cards with Readiris: scan your business
cards, recognize them and convert them into an address database. Think of your
last exhibition when you came back with an entire stack of business cards and it
took your secretary two days to encode them!

The cards’ data is extracted automatically from the image and the recognition
result is assigned to specific database fields. Readiris extensively uses a knowl-
edge database, thus acquiring the necessary intelligence to discriminate the first
and last name, a city and its state, a telephone and a fax number etc. The result-
ing data can be sent directly to your contact management software such as
Microsoft Outlook (Express) or any vCard compliant application.

Readiris supports a wide range of popular scanners: numerous flatbed scan-
ners, sheetfed scanners, “all-in-one™ devices or “MFPs” (“multifunctional pe-
ripherals™) and digital cameras can be used. Readiris also supports the Twain
scanning standard and some scanning platforms. Interval scanning allows you to
scan multipage documents efficiently when your scanner is not equipped with a
document feeder. (Readiris Corporate supports high-speed scanners and executes
batch OCR on large image collections: blank pages can be used to segment scanned
batches into separate documents, automatic bar code reading ensures the proper
indexing of the “dematerialized” documents.)
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Chapter 1
INSTALLATION

This chapter discusses the system requirements and installation of the Readiris
software.

SYsSTEM REQUIREMENTS

This is the minimal system configuration required to use Readiris:

U a 486 based Intel PC or compatible. A Pentium based PC is recom-
mended.

U 64 MB RAM. 128 MB RAM is recommended to process greyscale
and color images.

U 120 MB free disk space. 105 MB of disk space suffices when you
leave the sample files on the CD-ROM.

O the Windows XP, Windows ME, Windows 2000, Windows 98 or Win-
dows NT 4.0 operating system.

Readiris Corporate requires a monitor with a 1,024 x 768 resolution.

Note that some scanner drivers may not work under the latest Windows
version(s). Refer to the documentation supplied with your scanner to see which
platforms are supported.

I NSTALLING THE READIRIS SOFTWARE

The Readiris software is delivered exclusively on an autorunning CD-ROM.
To install, simply insert the CD-ROM in your CD-ROM drive and wait for the
installation program to start running. Follow the on-screen instructions.



Should the installation not begin to run when the CD-ROM is inserted in your
CD-ROM drive, run the setup program MENU.EXE to install the software.

Users of Windows XP, Windows 2000 and Windows NT must ensure that
they have the necessary access rights - contact the system administrator if
necessary.

Some installation options are offered. Be sure to install the linguistic data-
bases of all languages you intend to read. By default, all lexicons are installed.

You are recommended to install the sample images which are used in the tuto-
rials of this manual.

InstallShield Wizard

Select Components

Choosze the componentz Setup will install.

Languages T Description
Sample Images 17117 | | Inchdes the linguisic
Elecharic Marual e ldl | databases. Install the lexicon |
| of all languages you intend to |
Adobe Reader B4R K| | recognize. |
Change... 1
Space Required on C: 99398 K.

Space Available on C: OKB

< Back Mext » I Cancel I

Similarly, install the Adobe Reader software required to access the software
documentation, should this be necessary. The electronic manual is by default
copied to your hard disk. You can also leave it on the CD-ROM.
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The submenu "[.R.I.S. Applications - Readiris" under the "Programs" menu is
created automatically by the installation program.

Cardiris
IRISPen *
G Readiris » ﬁj L.R.1.5. on the Internet

@ I.R.I5. applications *

&7 Readiis
ﬁ Uninstall Readiris
E/E User's Marual

The same holds for a shortcut to Readiris on the Windows desktop. As a
result, you are able to start Readiris directly from your desktop.

UNINSTALLING THE READIRIS SOFTWARE

There are only two correct ways of uninstalling Readiris: using the Readiris
“uninstall” program and using the Windows (un)install wizard. You are strongly
recommended nofto uninstall Readiris or its software modules by manually eras-
ing the program files.

Readiris “ uninstall” program

Select "Uninstall Readiris" under the submenu "[.R.I.S. Applications - Readiris"
to start the Readiris “uninstall” program and follow the on-screen instructions.

G 1R.IS. Applications *

Cardiris ¥
IRISPen *

&) LR.LS. on the Internst

'\‘;ﬂ Readiris

,.* Uninstall Readivis

B3 User's Manual




Windows (un)install wizard

Execute the following steps to make use of the Windows (un)install wizard.
O Click "Settings" under the "Start" menu of Windows and go to the "Con-
trol Panel".

U Click the icon "Add/Remove Programs" under the control panel.

i Add or Remove Programs

re
E_;'ﬁ Currently installed programs: Sork by:
Change or ~
Rem%ve E Adobe Acrobat Size  75,35MB —
Programs 5 Cardiris Size  35,66MB
E 2 IRISPen Size 2,74MB
A E] Microsoft Office Professional Edition 2003 Size  174,00ME
Add New
Pragrams %] Readiris
@ Ta change this pragram ar r
AddjRemaove
Windows
Companents

£

Close

U Follow the on-screen instructions to remove the Readiris software.



USER s GUIDE

INSTALLING SOFTWARE OPTIONS

There are two software options available for the Readiris software: the “Asian
OCR add-on” and the “Hebrew OCR add-on”. The “Asian OCR add-on” allows
you to read Japanese, Traditional Chinese, Simplified Chinese and Korean.

% Readiris |Z”E‘

File Edit Settings View Process Learn Register Help
|
| OCR wizard

Scanning

# E B

&b
RIS ERER

Y DEFTAFRIE
EEEFRAEHNAREHE

EREFEFIANDEH
E e -

=
=

Source

Documeﬁt Type
Options
L L=
Scanner

- Hecognition
i Recognize
| . Ssave

g

FEDSHFTSTHM TN
WEE HEFTEHE F9
TS EFAWEDFEESF

BASTHRFF-FEHAFTREER
FEXRFIDEERES - ZEERE

5= |Elee

o

£atn

i
Chinese (Simp.)
L VE
-
ormat

L
F

2 |~ % ||

The “Hebrew OCR add-on” predictably allows you to recognize Hebrew docu-
ments.



il Readiris

DCR Wizard

- Scanning

=
"= scan
2
=]
Source
Dacument Type
Options
oY
=
| Scanner
-- Recognition

Recognize
Save

L @
Hebrew
)
Learn

4

Format

File Edit Settings Yew Process Lo

Register Help

TWHAN UV1pn X 0°D

07"l NX 1’77

YL T AT FTIAE LYY KD V3N DR DS SN TR BV BV,
DR T, DTS AT SRR AN T — ¢S SIMAWIY MYST P AN N
JIER-NEEE NIREE MR- PORE (24) S bR e

= AR, DY, ORI 0D, TV DT AR T TS B33 K R0
AR, ORI TP INBWRT TNPY MW 15 300 1Y PRI PRI D
TMEEY BTP OY 130 MR UYT 0N Y 0P IR 0D SRR MR
LIP3 JPPAIRD MK 1P 7790 Manw fam ~ nn obeb
210 T T OV 13NIR.ONPR D0 TR KT UKD

SR AR TORAY 0PN IR, 2N YAPT NP AR 00 130 YTan
=P 2 TN MY 1R TP 1 2100 R AR NP TN
=200 1P TR T 0P MR KT IR YA AR 0w 17,0
Jmnt

Lineskew Rotation

S|

& |Blele

i

& ]2 % &

These software options are again delivered on an autorunning CD-ROM. By
installing the “Asian OCR add-on”, specific documentation becomes available
that discusses how you can recognize Asian documents.
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Cardiris ~ »
IRISPen F
@ Readiis > @:l L.R.I.5, on the Internet

& IR.I5 Applications b

E Reading Asian documents
'f;ﬂ Readitis

ﬁ Uninstall Readiris

B User's Manual

INSTALLED FILES

The installation program has created a folder where the Readiris files are
located. Never try to uninstall Readiris or some of its modules by manually eras-
ing the program files, use the Readiris “uninstall” program or the Windows
(un)install wizard instead. See above.

Read Me file and documentation
README HTM  “Read Me” file (in HTML format)
MANUAL.PDF User’s manual (in Adobe Acrobat format)

Handprinting form
TEMPLATE.PDF  Blank handprinting form for reprinting
TEMPLATE.DOC Blank handprinting form for editing

Scanner drivers

Don’t hesitate to contact your scanner manufacturer or its representative should
problems with scanner drivers continue. Most manufacturers allow you to down-
load the latest versions of the scanners drivers from their web site.




REGISTER TO VOTE!

Don’t forget to register your Readiris license! Doing so will allow us to keep
you informed of future product developments and related I.R.I.S. products. The
registration benefits, including free product support and special offers, are
strictly limited to registered users.

You can register in many ways: by sending in your registration card or faxing
its electronic counterpart, by calling I.R.I.S. during working hours and by filling
out a registration form on the LR I.S. web site!

E? Readiris help g@@

& o &
Hide Back Home Frint  Dptions

Contents llndex ] Search]

Register Your Readiris

@ welcome to the Readiris help -

% Introducing OCR Llcense
Recognizing Documents
Recognizing Handwritten Text Why you should register
Recognizing Bar Codes
How to...? » Registering allows us to keep you informed of
Reference Infarmation future product developments and related
Software Versions and Options 1.R.1.5. products.

m Product Reqgistration

I@ Register your Readiris license
I@ Readiris registration form

@ Registering by e-mail

» Registering entitles you to free product support
and special offers.

e« Depending on the software bundle, you’ll
g Product Support receive the softkey in return as may be needed
RIS, . ) =

to continue using Readiris after one month,

How to...7?

Mail

Send in your registration card.
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The Readiris registration wizard as you’ll find under the menu "Register"
of the Readiris software can guide you through the registration process comfort-
ably.

Readiris registration wizard

‘welcome to the Readins registration wizard.
It allowes wou to register your Reading software icenze,

Reaiztenng allows us to keep you informed of future
product developments and related 1LR.LS. products.

Registering entitles you to free product zuppart and
special offers.

Depending on the software version you acquired, you’ll receive the softkey
in return as may be needed to continue using the Readiris software after one
month.

GETTING PrODUCT SUPPORT

The command "Product Support" under the "Help" menu of Readiris details
how you can get technical support. Please describe the phenomenon you experi-
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ence clearly and include all relevant data concerning Readiris, your scanner and
your computer system.

EEX

E? Readiris help

& S & o
Hide Back Harme Print - Options

Lontents ] Index ] Sealch]

How to Get Product Support

. Wwelcome to the Readiris help
@ Introducing OCR
Recognizing Documents
Recognizing Handwritten Text

Free technical support is offered to all registered
customers. (Reqgistering also entitles you to

Recognizing Bar Codes
How to...7

Reference Information
Software VYersions and Options
Product Registration

@ Contacting I.R.L.S. by e-mail

i@ 1R.IS.

@ How to get in touch with T.R.I.S,

special offers.)

Europe

Hotling: 32-10-45 13 64 (working hours) (all major
languages)
Fax: 32-10-45 34 43

usa

Hotline: 1-561-921-0847 / 800-447-4744 {working
hours)
Fau: 1-561-921-0854

WWW

wewewy iFislink . comyfsupport.html (troubleshooting
infa)
Click here to access the troubleshooting info.

E-mail
support@irislink.com, support@irisusa.com

GETTING IN ToucH wiTH |.R.l.S.

You can also contact I.LR.I.S. to learn more about other solutions from its
product range; the command "Contact [.R.I.S." under the "Help" menu of Readiris
details in which ways you can get in touch with .R.I.S.
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E? Readiris help
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e S

Lontents ] Index | Search |

Hide Back Home Print Options

. Welcome to the Readiris help
& Introducing OCR

Recognizing Documents

Recognizing Handwritten Text
Recognizing Bar Codes

Haow tao...?

Reference Information

Software Versions and Options
Product Registration

® Product Support

EQ| LR.IE.

@ Register your Readiris license

| Readiris registration form

m How to get product support

@ Getting product support by e-mail

@ Getting in touch with I.R.1I.S, by e-mail
[f] How to acquire software and hardware
@3 L.R.15. on the Internet
43 Readiris on the Internet

How to Get in Touch
with I.R.I.S.

Head Office (Belgium)
Phone: 32-10-45 13 64
Fasx: 32-10-435 34 43

I.R.I.S. on the Internet

LR.I.S. home page: httpe e irislink  com
Readiris web site: bttt Hfwww readiris.com
On-line shop: http:ffshop.irislink.com
E-rmail info: info@irislink.com

E-rmail sales: sales@irislink.com

E-mail support: support@irislink.com,
support@irisusa.com

usa Office
Phone: 1-561-921-0847 / 800-447-47 44
Fax: 1-561-921-0854

An application icon in the submenu "[.LR.I.S. Applications - Readiris" under the
"Programs" menu takes you directly to the I.R.I.S. home page. So does the
Readiris startup screen and the command "[.LR.I.S. on the Internet" under the

"Help" menu of Readiris.
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f 1R.IS. Applications » |

@ Cardiris  »
@ rIsPen »

|
& Readitis »

I A 1R.LS. onthe Internet
‘%ﬂ Readiris

Uninstall Readiris
@ User's Manual
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Chapter 2
GUIDED TOUR

Readiris is a state-of-the-art OCR package equipped with numerous advanced
features. We will discuss all major features in this chapter and add many tips and
hints concerning the use of Readiris.

STARTING THE SOFTWARE UP

Click on the Readiris application in the submenu "L R.I.S. Applications - Readiris",
or click on the shortcut to the Readiris application on your desktop.

Cardiris  »
IRISPen »
fi Readiris  » ﬂ:[ L.R.L.5. on the Internet

M@ LR.IS. applications »

%] Readiris
ﬁ Uninskall Readiris

B4 user's Marual

The Readiris startup screen and application window are displayed. The startup
screen displays the version and copyrights of the Readiris software. It also gives
direct access to I.LR.I.S.’s home page - simply click on the URL to visit the
LR.LS. web site. Clicking the mouse anywhere ¢lse makes this screen disap-
pear.

The next window concerns the OCR wizard; click "Cancel" for the time be-
ing.



THE FIRST-TIME STARTUP

Depending on the software bundle you acquired, the first startup may be spe-
cial: you may be prompted to register your licence.

If this is the case, the use of Readiris is limited to 30 days, and by registering,
you receive a free softkey from I.R.1.S. to continue using the software after the
first month.

It takes your identification number to generate the softkey; be sure that
this number is available or mentioned when you register your licence.

Readiris §|

The identification humber on thiz machine iz

JICM 425350033038 3203253544 4208080 Help

To enable thiz software, you need a key.
Fleaze contact [.F.1.5. to obtain thiz key

Enter your key number;

0k | | don't hawe thiz key

DiscovERING THE READIRIS INTERFACE

The Readiris application window not only contains command menus but
also two button bars that give quick access to all frequent commands. Initially,
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some command menus are dimmed: they concern the preview. As long as no
image is opened, they are unavailable.

%t Readiris

File Edit Settings View Process Learn Register Help
%n.
E DCR Wizard

1 Scanning

Source

Options
Scanner

Recognition

2

Recognize
Save

The same goes for the image toolbar on the right side of the application
window: it contains all commands you need during the image preview. The main
toolbar on the left gives quick access to all frequent general commands.

To learn which command corresponds to a certain button, hold your mouse
pointer over it for a while: a tooltip will tell you what the button does.



%] Readiris

File Edit 3Settings Yiew Process

wi,
r OCR Wizard
ﬁ Scanning

Scan

Capture image

The window pane or image zone is where the scanned images are dis-
played. You can drop image files onto the image zone (and on the Readiris icon)
to recognize them.

As soon as pages gets processed, an additional toolbar, the page toolbar . is
added on the left side: it represents the various pages of the document and gives
access to the page commands using the right-click (the "Context" menu).
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%] Readiris

File Edit Settings Yiew Process Learn Reqisker
s,
i,

EDER Wizard

Scanning

[ 25
Source
=Y
Cpkions
=

Scanner

Secondly, the document panel is then displayed below the scanned image. It
displays statisticsand information on all scanned pages - the image source and
resolution, the scanning and recognition time etc. (The document panel comes
with tooltips too...)

Page | Image source Scan time | OCR time | Resolution | Width | Height | Lineskew | Rotation  #
1 Ci\Program Files\Readirisimultipage. tf - 2.74 - 300 2000 2388 - = =

2 C\Program Files\Readirisimultipage. tif - 2.08 - 300 2000 1888 - - =
3 C\Program Files\Readiris\multipage.tf - 2.05 - 300 1912 2004

GETTING STARTED WITH A FIRST TUTORIAL

The best way to become familiar with the operation of Readiris is undoubtedly
by using it. A number of prescanned images is provided with the software;
they allow you to get started even when there is no scanner connected to your
computer. Let’s turn to these now.
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The "Source" button on the main toolbar determines whether you are going to
use a scanner or a prescanned image as image source.

Color, greyscale and black-and-white images are supported on an equal basis.
Readiris allows you to open Adobe Acrobat PDF documents, DCX fax images (a
multipage version of the Paintbrush format), DjVu images (*.djv, *.djvu), JPEG
images, JPEG 2000 images (*.j2¢, *.jp2). PNG images, TIFF images
(uncompressed, LZW, PackBits, Group 3, Group 4 and JPEG compressed),
multipage TIFF images, Windows bitmaps (*.bmp) and ZSoft Paintbrush images
(*.pex).

This capability is particularly useful to convert your faxes into editable text
files.

As you are going to open a prescanned image, you should select "Image Files",
and not the scanner, as image source with the "Source" button.

@ Open
Soul  Scanner

| O_panns I

Next, click the "Open" button. (When you select the disk as image source, the
"Scan" button is replaced by the "Open" button and the corresponding "Scan"
command under the "Process" menu is replaced by the "Open" command.)

‘ g Scan ‘ @ Open

You could also select the command "Open" from the "File" menu and open a
prescanned image directly - this works even if your scanner operates as current

image source.
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You are invited to select an image file. Select the file ENGLISH.JPG in the
Readiris folder. As this sample file is a color image, it is not only read from disk:
a “binarized”, black-and-white version is created for the OCR process.

Canverting

Loading D:\Readirizhenglizh.jpg. .
34%

Finally, the image is displayed in the image zone. The page toolbar and docu-
ment panel indicate that a single page is loaded into Readiris.
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Fle Edit Settngs View Process Llean Register

¥ THERE'S ONE PART OF THIS MAGAZINF 1 TRY HARD NOT
to read i's the section we call Numbers, near the front.
My colleague who prepares it (I dare to write this be-
cause she’s on \mca[mnl has lhehudmrcuu:ngmhsncs

Scanning

Scan

Give the Brain a Break

A device to avoid being sucked under by the information maelstrom

world live in some form of slavery. That nees to be stored and
pondered. As does, say, a recent finding by the London Schoal
of Economics that four million British children live in poverty,
relative though that is, This knowledge can't be DNKed if we are

‘which some mental kin: the propo

of Dutch couples who live in what used to be called sin (32%);
the amount paid at auction for an Eric Chplon guitar
($497,500); the estimated number of condos used in the
world annually (9 illion); or how high the pile would be if Bill
Gates stacked his wealth in §1 bills (25,000 km).

The trouble with this fun is that it leaves stat chots in your
brain. If you can't do some plumbing
to restore thinking's normal flow, they
aceumulate like cholesterol up there
in the grey matter's byways, causing
serious mind-blocks. After three glss-
e of red you declare over dinner that
Bill Gates has used nine billion eon-
doms, Eric Clapton had a 25,000-km
long guitar, and 32% of Dutch couples
earn $497,500 a year, The only cure
for this condition of factoid overload—
a sort of neuronic plague which is set
to be the main cause of mental illness

Recognize
. Save

L @

English
in the 21st century—is to learn to sift.
% Survivors will be those with the capac-
Learn ity to distinguish Internet surfing from

info-surfeit.

“The first step to becoming a sworn
sifter is easier than giving up smoking.
It only requires a little virtual brain
surgery to find a warm spat in one of
your lobes and implant there an imag-
Inary device smaller than the delote koy on a computer, Psy-
chotherapeutic, but as efficient as dopamine or serotonin, its
‘medical acronym might be DNE, which is not & kinky variant of
o but stands for Don’t Need to Know.

After undergoing a voluntary oNg implant, | now shiver
with pleasure on opening my morning newspapers as factoid
after factaid that 1 dont need on my poor ald soft disk is burned
from memary's gates. An example: scientists in Texas say each
year the Earth and the Moon move 3.82cm further apart,
meaning that since Neil Armstrong was taking giant steps
there 30 years ago, we are 1l4em more distant. Standing at the
‘back door looking up at the Big Cheese, does my soul benefit
from this knowledge? No. Slam by it!

There are forests of facts which can not be so easily shed,
as with some of the far-from-trivial statistics that jolt in our

A t pleis that i le in the:

4

Format

‘human, but precisely here is sucha wel-
ter of factoids the i of big numbers like these dil
into a milly way of mental numbness.

It's not just numbers, it's also words. Don't-Need-to-Know
beginners can, for example, zap any report to do with rats. Nat
the sewer sort but the laboratory kind, the anes which almost
daily lead to variants of: “Tweaking gene BS6G and injecting
fiubobioxidioninase greatly reduces
hair loss in male rats over 50. Scientists
at Brillolab caution that many years of
research will be required before.

Sport offers superb DNK material,
You can whiteout all that coaches say
before a match and most of what they
say after it, along with what the play-
ers mutter about why they last/won,
Its the event, stupidl If you've
watched Lance Armstrong through
. each stage of the Tour de France, do

you really need to learn it wasn't easy
on his legs?

Politics is the promised land of
owk, Meaning you blank all promises
and pre-election bumpf, all state-of-
the-nation monologues. One needs to
take in anly how the votes fall, all de-
nials (on the where-there’s-smoke ba-
sis), and party funding figures, Where

. politics bleeds into economics, there is
also room to turn a deaf ear. pNK all interest rate forecasts,
stockgazing and merger talk because it's about as accurate as
tarot, and anyway you never hear it in time to benefit from it.

Criticism can be a joy, but keep the pnk button ready for
those experts who can't resist giving the whole plot away, ex-
plaining what the painting really means, or who majored in
semiotics IF's easy to build such personalized bk lists. My own
lang one also includes all advertisements (especially those of-
fering “personalized” things), and anything to do with any roy-
al marriage, anywhere. Also flamed out are all numbers about
flying saucers, mobile phone sales, desirable cholesteral levels,
winners of the U.S. Masters, and guesstimates of how much Bill
Gates has in the bank, or how it might stack up.

The ok club is free and there are no membership num-
bers. Our eathastic motto might sound. familiar—if you haven't
yet pxked out all slogans . It's No drain, no brain.

Page | Image source Scan kime | OCR time

Resolution

Width Lineskew Rokation

A third way of opening prescanned images is the use of “drag and drop”:
drag images from the Windows Explorer onto the Readiris image zone or on the

Readiris icon and they are promptly opened.
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7 start

You can even open images from within the Windows Explorer: right-click an
image file and select the command "Recognize" from the "Context" menu. (This
command only appears when the file’s file type is supported.)



2-10

x Mame Size | 1
| [H excel.ibt 1KB It
[ Earyt 20KE Y

=
F Preview KB T
Fii 20KB ¥
= m ke v
T Edt
%] Frr , 93ZKE A
~ Prink
%] Frr - JOKE A
Resize Pictures
|3 Fre Gl4KE 1
FR  Open With ’ 20KE ¥
02 KB ¥
Send T 3
w0 S44KE
GF o Cut 1KE ¥
Bl copy 975KE I
ar . S9TKE ¥
gr Cnlaate Shorkouk L364KE ¥
q| Delete Z0KE ¥
he REname Z0KE ¥
he Properties Z0KE Y
b e BSKE D
iz

That does not mean the OCR is promptly executed: to give the user full flex-
ibility, Readiris is simply started up and the image is opened.

The image toolbar on the right side of the Readiris application window con-
tains all commands you need during the image preview: tools to indicate the zones
of interest, to rotate the image, zoom in and out etc.

ZOOMING IN ON IMAGES

Readiris has several commands that allow you to zoom in on a scanned im-
age, for instance to verify the scanning quality.
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The image toolbar contains buttons that allow you to zoom in at real size, to fit
the image to the page width and to fit the entire image in the preview window.
The "View" menu contains the same commands and adds two extra zoom levels:
you can display the image at 50% and 200% of its actual size. At actual size, a
screen pixel corresponds to an image pixel. (Shortcuts are available for all zoom
levels!)

Ij' YWigw
L, v Fit to window

|ﬂ| Fit ko wWidth Chrl+t
Actual Size Chrl+1

!
i1 200% Actual Size Chel+2

Also notice that the zoom levels are available on the right-click. Click with the
right mouse button to invoke the "Context" menu and select the appropriate zoom
level.
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Furthermore, you can double-click the right mouse button over a region of the
scanned image to zoom in at real size immediately. Repeat the operation to zoom

out again.

Finally, you can use the magnifying glassto zoom in on details of the scanned
document. The magnifying glass is also available on the "Context" menu when
you right-click the mouse over the image.

View

| Awordabou

window
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ONE, DECOMPOSING A SCANNED IMAGE

Now that the image is scanned, you have to indicate which parts you want to
convert into editable text by drawing frames, so-called “windows”, around the
zones of interest.

Actually, Readiris will do this for you automatically when the option "Page
Analysis" is enabled under the "Options" button on the main toolbar (or under the

"Settings" menu).

Page Deskewing
Deteck Page Crientation
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Automatic page decomposition is particularly useful when columnized texts
and documents with a complex page layout, possibly including graphics and tables,
are recognized.

File Edit Settings View Process Learn Register Help

OCR Wizard

8 - <l s the c dcmdbdmﬂyur:u:nl'imhnsb}n
canning | "ycg\]me\lmammnﬂdmb‘mkﬂm ‘Fron illion Britih childran livein po

sormes merntal micotine mskes you suck in: the prop

=%

Source
=l
Options
S

Scanner

Recognition

Recognize
Save

English
K
Learn
Format After undergoing a veluntary prE Imrﬂlm 1 mw

 pleasure cn apening my merning newsmpers s fa
r factosd that o neecl o my poar ld sofldisk is b

Page decomposition uses three window types: text, graphic and table win-
dows. Readiris discriminates text blocks, tables and graphic zones containing
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photos, illustrations etc. on the page. (Saving graphics and recognizing tables will
be discussed at great length below.)

Two extra zone types are always drawn manually: bar code zones and
handprinting zones. (More about bar code reading and the recognition of hand-
written “block letters™ later.)

A color code indicates the window type: text zones have an orange border,
graphic windows have a purple border and tables a pink border. Bar code zones
are green and handprinted zones are blue.

The number of windows is indicated at all times in the tooltips of the window

tools.
Drraw bexck window: & Draw graphic wmdu:uw 1 Draw table wmdnw 0
S g v
|Draw bar code window: 0| [Draw handprinting window: 0

Page analyisis is fast, skew-tolerant and highly accurate: it traces complex,
“irregular” shapes.

[

:apa- DOWNSIZED
‘ane- DISPLAY: Sceptre’s
te of CD-1112T LCD panel

onn is so svelte that you can tuck it in

The page analysis will even detect zones where you get white text on a
black background. Recognizing such inserts is no problem: while the preview
displays the scanned document correctly on-screen, Readiris “inverts™ the image
when the need arises to recognize such text blocks! (You can have your scanner
generate fully inverted images to process pages with white text on a black back-
ground. See below.)
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ONE AND A HALF, SorTING WINDOWS

Readiris not only detects the various blocks, but also sorzsthem: the zones are
sorted top-down, left to right by default to cope with columnized documents.

Evidently, you can modify the sort order. To do so, click the "Sort" button on
the image toolbar. The mouse cursor becomes a pointing hand as soon as the

“sort mode™ is enabled.
']

Click on the windows you want to include. Windows you do nof click on are
simply ignored, excluded from recognition. It’s easy to see which zones are se-
lected and which aren’t: the selected windows have their full color, non-selected
windows have a lighter color tone and have no number.
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Page analysis is enabled by default. To force Readiris to decompose the cur-
rent page - because you disabled page analysis by accident, because you erased
some windows erroncously and want to redo the page analysis etc. -, you can
simply click the button "Analyze Page" on the image toolbar.
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Select the document language before executing the page analysis when you
are dealing with Asian and Hebrew documents. Specific routines are used for
these languages: the interline spacing of Asian documents is in most cases bigger
than in Western documents, the text is made up of small icons (“ideograms™) that
could easily be seen as graphic zones in Western documents and the text may run
from top to bottom, from right to left. In Hebrew documents, the text runs from
right to left. And if you forgot to select the proper language, select it afterwards.
Readiris re-executes the page analysis automatically!

Some documents have many “stray” dots on the page, may generate a black
page border around the actual image ctc. To erase all small windows - it’s as-
sumed they don’t contain any text - and re-sort the remaining zones, you can
click the command "Delete Small Windows" under the "Edit" menu.

December 12, 1068

Delete Small Windows  Cerl+M

Another similar routine is automatic: the detection of zones on the page bor-
ders. When this routine is disabled, the page analysis ignores any zones that touch
the page borders. When your scanner generates black borders around the actual
image, page analysis tends to find zones where there’s only “noise”. Graphic
zones on the page borders are left untouched: photos often touch the page bor-
ders, background graphics in most cases cover the entire page etc.
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v Page analysis
v Do Mok Detect Windows on Borders

Two, WINDOWING A SCANNED |MAGE M ANUALLY

Page analysis is the automatic way of windowing a scanned page. Alterna-
tively, you can zone an image manually with the windowing tools of Readiris.

Select window

[Draw bext window: 0]

[Draw graphic windawe: 0]

|Draw kable window: O |

|Draw bar code window: D|

"z
'E._J |Draw handprinking window: E||

(As indicated earlier, bar code and handprinting windows are always drawn
manually by the user: the page analysis does not detect them for you!)

To draw a rectangle around a zone of interest, select the corresponding tool
in the image toolbar and drag the cursor from the upper left corner to the lower



right corner of the window. (Sides smaller than 1 mm are not allowed, they
wouldn’t even contain a single character anyway.)

Not to worry should you have selected the wrong zone type: you can quickly
change the type by right-clicking the mouse over a window and selecting the
command "Window - Type" from the "Context" menu.
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The windows are automatically sorted in the order of creation: numbers indi-
cate the sort order.

You can also frame “irregular” text blocks by drawing polygonal windows
around them. Non-rectangular windows are created by merging rectangular zones:
as soon as two rectangles (of the same type) intersect, they become a single
window automatically! In a way, you’re building a house by adding one room
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after the other... (Creating polygonal table and bar code windows doesn’t make
any sense.)

championships as coach of the Chicad |
go Bulls, Phil Jackson is—literally—=| |
packing it in. Days after Michael Jory

'ach was clea_nmg out his office at the
team ’s practice center in Deerfield, I1L Inan

Furthermore, manual windowing can be combined with window sorting: you
can draw new windows even when the “sort mode™ is enabled. You then use
sorting to include a number of detected windows and manually create some other
windows where the page analysis didn’t yield the appropriate results. As soon as
you start creating windows in the “sort mode™, all zones you didn’t select are
promptly erased!

To modify, move and delete windows, you need to select them first. To do so,
select the "Window Selection" or “arrow” tool in the image toolbar and click
inside a window. Rectangular markers now appear at each corner and in the
middle of the window sides.

Ll

To unselect windows, click the mouse button elsewhere. To select addi-
tional windows, hold down the Shift key while clicking on these extra windows.




To select a window and the included windows (of another type), hold down the
Ctrl key while clicking on the main window.

So much for selecting windows. To modify a window, select it, put your
mouse cursor over a marker and drag the side to change the window size.

To move a window, simply select it and drag it to another location.

To delete windows, select them, right-click them and select the command
"Window - Delete" from the "Context" menu. Doing so deletes all selected win-

dows as well as the window under your mouse cursor.

P
1 €C Oa‘?gman

Copy as Text

Alternatively, you can select zones and choose the "Cut" or "Clear" command
from the "Edit" menu. The "Cut" command cuts the window(s) to an internal
buffer, "Clear" erases the window(s) irretrievably. When you paste zones, they
are inserted in their original position, and you have to drag them to their new
location.

In fact, a//familiar commands from the "Edit" menu apply to the windows: you
can delete, cut, copy and paste them! The "Undo" command also applies: if you
have unfortunately deleted, moved, resized etc. some windows, "Undo" will can-
cel the last operation.
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Cuk Chl+
Copy ChelHHC
Paste Chrl4+Y
Clear Del

Delete Small Windows  Cerl+M
Select All ChelA

Also note that shortcuts are available for all commands! Let’s give an ex-
ample: to erase all existing windows, you can choose the command "Select All" or
its shortcut Ctrl+A and click the command "Clear" or its shortcut Delete. You are
now ready to recreate the necessary layout. To restore the previous layout, you
can choose "Undo" or the shortcut Ctrl+Z.

THREE, SaviNG WINDOWING TEMPLATES

The resulting windowing layouts can be saved as zoning templates for
future use with the command "Save Layout" under the "File" menu and loaded
into memory with the command "Load Layout".

Save Layout... g

If you have to recognize documents with a similar layout, for instance a 50
page report where the header and footer should be excluded for obvious reasons,
a single template can be applied to zone all 50 pages.

When you load a template into memory, page analysis is disabled automati-
cally. The zoning template remains active until you re-enable page analysis on the
main toolbar. When you’re loading a layout into memory, you can enable the
option "Apply Layout to All Pages" to apply it promptly to all pages of the current
document.



]
File narme: |Ia_l,lout
Files of type: |La_|,|out file: ﬂ m

v Apply lapout bo all pages

Actually, there’s a nice alternative for zoning templates: the preview tool "Ig-
nore Exterior Zone" limits the page decomposition to the “cropped’ portion of the
image.

Select this tool and frame the portion of the image you want to process. When
you’re dealing with a multipage document, you can exclude the same outer zone
from page analysis on every page. (Re-execute the page analysis to cancel the
image “cropping”, or change the zones manually.)
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60,000 shares; on the days he posted his messages volume,
ﬁ Scanning soared to more than a million shares. More to the point,|
he'd made money. Between September 1999 and February|
2000 his smallest one-day gain was $12,000. His biggest was
$74,000. Now the kid had agreed to hand over his illicit|
I_ = gains, plus interest, which came to $285,000.
= When 1 first read the newspaper reports [ didn't under
stand them. It wasn't just that I didn’t understand what the|
Jﬁ kid had done wrong. I didn't even understand what he had
Options done. And if the first news stories about Jonathan Lebed
gﬁ raised questions—What did it mean to use a “fctitious|
name” on the [nternet, where every name is fictitious? Wha|
were these people who traded stocks naively based on what
they read on the Internet?—they were trivial next o the|
questions raised a few days later, when a reporter asked
[Jonathan Lebed's lawyer if the SEC had taken all of the prof-
its. They hadnt. There had been many more than the eleven
trades described in the SEC's press release, the lawyer said.
The kid's take from six months of trading had been nearly|
$500,000. Initially the SEC had demanded he give it all up,|
then backed off when the kid put up a fight. As a result,
[Jonathan Lebed was stll sitting on half a million dollars,
which he'd made in less than six months of wading.
= At length, T phoned the Philadclphia office of the SEC,
Format where I reached one of the investigators who had brought|
[Jonathan Lebed to book. 1 was maybe the fiftieth journalist
he'd spoken with that day, and apparently a lot of the others
had had trouble grasping the finer points of securities law.
At any rate, by the time [ asked him to explain to me what,
18
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i C\Documents... 134 1341 2271

ReaDIRIS TAKES You AROUND THE WORLD

Assuming that the windows are correctly defined, you are now almost ready
to execute the character recognition. We say “almost”, because we haven’t veri-
fied the language and document settings yet.



The language setting can be found on the main toolbar.

e S I

| English

Click the "Language" button to modify the document language.

[ Mumeric

.

|English -

Chineze [Simplified] ~ C |
Chinese [Traditional) 7 stk
Corsican
Croatian
Czech
Danish
Diutch

E ztonian
Faroese

Fijan

Finnigh
French

Frigian

Friulian
Galician
Ganda
German
Greek,
Greek-Engligh
Greenlandic:
Haitian Creale
Hani b

You can press a letter key to move to it directly: if English is currently se-
lected, and you want to select Occitan, you can click the "O" key on your key-
board to go directly to the Occitan language. When several languages have the
same initial, press the letter several times to go through the options. Let’s give an
example: Readiris reads English and Estonian. By pressing "E" once, you select
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English, by pressing "E" a second time, you select Estonian, and by pressing "E" a
third time, you’re back on English. (To go to anotherletter, say T, press BackSpace
before you enter the "T" character.)

Readiris is far from limited to English: up to 117 languagesare supported! All
American and European languages are supported, including the Central-Euro-
pean languages, Greek, Turkish, the Cyrillic (“Russian’) and the Baltic languages.

Optionally, you can read Hebrew and Asian documents: the extra module
“Hebrew OCR add-on™ predictably offers recognition of Hebrew documents,
the software option “Asian OCR add-on” offers recognition of Japanese, Simpli-
fied Chinese, Traditional Chinese and Korean. (Simplified Chinese is used on
China’s mainland and in Singapore, where Traditional Chinese is used by Hong
Kong, Taiwan, Macau and the overseas Chinese communities.)

Also note that the British and American - or should we say “international™? -
variants of the English language are distinguished. The same goes for Spanish
and Mexican.

It takes the appropriate Windows configuration to display Central-European,
Greek, Turkish, Cyrillic and Baltic characters. You may have to install the Win-
dows multilanguage support before your Windows system is able to cope
with these languages.

On a Windows XP, 2000 and Windows NT 4.0 operating system, select the
icon "Regional Settings (and Languages)" under the "Control Panel".



Regional and Language Options

Regional Options | Languages |Advanced

Teut zervices and input languages
To wiew or change the languages and methods pou can uze to enter

texst, click Detals.

Supplemental language support
Mozt languages are installed by default. To install additional languages,
select the appropriate check box below.
Install filez for complex script and right-to-left languages (including
Thai)
Install files for Eazt Agian languages

QK ] [ Cancel ] [ Apply

On a Windows ME and 98 operating system, select the icon "Add/Remove
Programs" under the "Control Panel" to find out if the module “Multilanguage
Support™ is installed on your PC.
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Add/Remove Programs Properties EHE
Install/Uninstall  Windows Setup | Startup Diskl

To add or remove a componert, click the check box. A shaded baox
means that only part of the component will be installed. To zee
what's included in a compaonent, click Details.

LComponents:
£ Microsoft Exchangs 42MB ||
[ & Microzoft Fax 0.0MBE
Q Multilanguage Support 10.4 MB
82 Multimedia 1.1 MB
1 [&] The Microsoft Network DOME [7]
Space required: 1.2 MB
Space available on dizk: 29.3MB
r— D'escription
Includes aptions to change keyboard, sound, display, and
mowLse behavior for people with mobilite, hearing and visual
Impairments.
1 of 1 components selected Details. .. |
Have Disk... |

Ok, I Caticel | Sl |

To view and edit Asian and Hebrew documents, you can install an Asian and
Hebrew version of the Windows operating system or use Word 2003, Word 2002
or Word 2000 to view and edit such documents: Office 2003 System, Office XP
and 2000 were specifically designed to cope with documents in many different
languages. Refer to the Readiris “Read Me" file for more information on this
subject.

Selecting the proper document language is imperative. Based on the selection
of a language, the software knows which symbol set to recognize. Multi-lin-



guistic support ensures that “exotic” characters such as ¢, B, fi, vy and o are
recognized correctly.

Secondly, the software extensively uses linguistic databases to validate its
results. Suppose that you have to read the word "president" where an ink stain
makes the "r" look like an "f". Looking things up in the English lexicon, Readiris
will detect autonomously that the word "president" is being read and that it doesn’t
make any sense to recognize the symbol "f". This “ self-learning” techniqueis
of course highly dependent on the linguistic context.

Linguistics offer useful help to solve ambiguous cases such as an "O" which
might be mistaken for a '0'. Another typical example is the letter "1" and number
'1' which have an identical form in many fonts - think of texts produced on old
typewriters! The linguistic context helps to determine whether you are dealing
with "l" or '1".

The illustration below shows various shapes of '1' and "1". The shapes on the
first line are unambiguous, the shapes on the second line are ambiguous, but
linguistics can solve them. When the context does not suffice, the user inter-

193 1950s. hr
Well, Rossellini

User LExicons To “Boost” THE LINGUISTICS

You can take the linguistic “feedback’ one step further by customizing it: as
powerful as the standard lexicons may be, users of Readiris Corporate can “boost™
the OCR accuracy further by loading user lexicons with the command "User
Lexicon" under the "Settings" menu.

Uzer Lexican o Mone
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The tooltip of the "Language" button indicates which user lexicon is currently
active.

Select document language: English, User Lexicon: C:'I,Readiris'l,sample.txt|

User lexicons are word lists containing any term that does not occur in the
“basic”, general purpose lexicons. Think for instance of technical, scientific, legal
or other company-specific terms!

Readiris is accompanied by the User Lexicon Editor, a utility designed to cre-
ate and maintain such user lexicons. This tool is very user-friendly; consult its
on-line help should you have any doubts about its operation.

% User Lexicon Editor, - sample.ixt

File Help
MHew word:
Brugada Add
arnyloid ~
amploidoziz -

angiogranm %
angioplazty

angi_osarcoma E m
arteragram

atheractomy

atherozclerosis
atrial

atrioventricular

bradycardia Open.
calcific

capotil Impart..
cardiomegaly

cardiomyopathy Save
cardiothoracic

cardioverter E it

| £




You’ll find this editor in the submenu "[.LR.I.S. Applications - Readiris" and
under the "Settings" menu of Readiris.

Cardiris ¥
IRISFEn »
& Readiis »

@ I.R.IS. Applications *

@ L.R.I.5. on the Internet
@ Readiris

ﬂ Uninstall Readiris

B3 User's Manual

=% |ser Lexicon Editar

Edit User Lexicon. ..

REeADIRIS CHANGES LANGUAGES As NEEDED

But the buck doesn’t stop here: Readiris can switch languages in the middle of
a sentence without any help from the user! When Western words pop up in
Greek, Cyrillic, Hebrew or Asian documents - many untranscrible proper names,
brand names etc. are written using the familiar Western symbols -, Readiris can
switch to the correct alphabet automatically. In other words, you can activate a
mixed alphabet of Greek, Cyrillic, Hebrew or Asian and Western characters.

Be sure to select "Greek-English" or the appropriate Cyrillic language setting
- for instance "Byelorussian-English". In other words: don’t try to just select
"Greek" or "Byelorussian" as document language and hope that the Western sym-
bols will come out fine!

| 2] ]2
| |

Greek-E Russian-E

Here’s an example where a Russian text contains some English words - open
the image file ALPHABETS.TIF and recognize the corresponding page if you
want to try it for yourself!
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5| Readiris |Z‘ |E| ‘Zl

File Edt Settings View Process Learn Register Help

.
B oo s

“ Scanning - . .
S scon Russian - English g
s IIpennasnavuenneM cucTeMbl ONTHYECKOTO |
Source -

L B PacniosnaBanus 3HaKoB ABTISIETCH || 7
| & * | aBTOMaTHYECKHU BBOJI IIEYaTHBIX |~
scarner JIOKYMEHTOB B IIaMATh KOMIIBIOTEPA KpaiHe

W2l Pecogniion 5b}eKTHBHEIM M JEIEBBIM  TYTEM. | o
| e HecMoTps Ha To, uto pa3paboTka OTOi | &
i cucremb! (OCR) Oblta npeanpuuaTa emé I
= 20 nmet Hazan, 3Ta TEXHOJIOTHMsA €IIE IIOKa 5
tea HEW3BECTHA IDUPOKOH  myOiuke 1S ‘é |

= aBTOMATHYE€CKOro BBOJA MarepHajia H

JIOKYMEHTOB. i

i
| Page | 1mage source Scantime | OCR time | Resolution | Width Height Lineskew | Rotation 3'
e e 0w - e &

C:\Program Filesy...  0.75 = 300 907 643

The end result looks like this when opened with the wordprocessor - you may
have to select a Cyrillic font to display the Russian text correctly.



File Edit Yiew Insert Faormat Help

DeEd Sk M

|TimesNewF|oman v| |13

v By
v||Western Bl e -0 = =
§-|-1---2---3-|-4-|-5-|-s-u-?-u-a-u-s-|-1u-|-11-|-12---13--

@
IIpegHasHadeHMaM CHCTEMB] ONTHYeCKOT0 PAclosHABAHHA SHAKOE ABIAeTC
ABTOMATHYECKHA BB O] N2 YATHBIX [ OKYMEeHTOB B [AMITh KOMILHOTEpA KpariHe

s er TN eI EEEM Ty TEM. HecMoTpa Ha To, 9T0 paspaboTia sTof
CHCTeME @

BpL1a npennprraTa emré 20 JeT Hasan, 5Ta TEXHONOTHA Ié MOKa

HeHIBECCTHA T

Kok nybImke ONd aBTOMaTHHeCKOro BEOJIA MATEPHANA H
JOKYMEHTOE.

JFor Help, press F1

MU

ReADING DocuMENTS WITH MIXED LANGUAGES

Readiris Corporate is more powerful when it comes to reading documents
that cover several languages: with that version, you can select a primary lan-
guage and (up to 4) secondary languages (of the same language group).
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[ Mumeric

|English |

Secondan languages Cancel

i

[Faroesze ~
CIFijan
CJFinnish

[ French E
[CIFrizian

CJFriulian

G alician

OGanda

German v

Wwiarning: enabling extra languages slows down
the recognition and may decreaze the OCR
accuracy

To read a document where the French translation occurs alongside an English
text, you’d select English as main language and French as secondary language or
vice versa. Mind you, you don’t just extend the character set to include the ac-
centuated characters such as ¢, ¢ and u. Both linguistic databases provide linguis-
tic “feedback™ to the OCR process, and this allows Readiris to “auto-detect”
which language is used where in your document!

You can select up to 5 languages simultancously. Only languages that belong
to the same language group can be combined: languages that are covered by
another Windows code page than the “main” language can not be activated si-
multaneously. But first and foremost, don’t select languages that don’t apply: the
bigger the character set, the slower the recognition and the bigger the risk for
OCR errors!



Should you need to learn quickly which languages are currently selected, the
tooltip of the "Language" button enumerates them. ..

bl
= elect document language: English, French

=

el

DerFINING THE DocuMENT CHARACTERISTICS

Now that the language is set, we’ll turn to the other document characteristics.
You can fine-tune the recognition by specifying some document features: the font
type and character pitch. (These commands do not apply to Asian documents.)
Let’s clarify what this means.

Let’s start with the command "Font Type" under the "Settings" menu. The font
modes separate “normal” documents from dot matrix printed documents. “Draft”
or “9 pin” dot matrix symbols are made up of isolated, separate dots, and highly
specialized recognition routines are used to recognize them.

ape-descended litfe

“Letter quality” dot matrix printing, also called “25 pin” or “NLQ” dot matrix,
requires the “normal” setting, as do the printing qualities typeset, typewritten,
laser printed and inkjet printed.

The setting "Automatic" means that Readiris will detect the font mode auto-
matically. Let Readiris “auto-detect” the font mode in all cases - unless you are
sure only dot matrix documents are being read! (Obviously, "Automatic" is the

default value.)
Dok Makrix

The font type is indicated in the tooltip of the "Recognize-Save" button: when
no message is added to the tooltip, the “auto-detection™ of the printing quality
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applies, when the message "Dot matrix" shows up in the tooltip, the dot matrix
reading mode is enabled.

Recognition

Recoqnize
== Sa\re

\— |F‘erfu:urm texk recognition: Dot matri><|

The character pitch can be set with the command "Character Pitch" under

the "Settings" menu.
Character Pitch m
Fixed

Propartional

With fixed or “monospaced” fonts, all symbols of the font have the same
width. An "i" takes up as much horizontal space on a line as a
"w", as is the case in this sentence. Think of documents produced
using a typewriter, where the carriage moves a fixed distance for each typed
symbol.

A proportional pitch means that the width of a character depends on its shape.
Symbols like “m” and “w’” are wider, take more horizontal space on a line than the
“thin” characters “I” or “§”. Virtually all books, magazines and newspapers are
printed in proportional pitch.

The simplest solution is to leave this option at all times on the default value
"Automatic", which means that Readiris will detect the character pitch automati-
cally.

READIRIS GETS MORE INTELLIGENT EAcH TIME!

When the document language is selected and document characteristics are
set, enable the interactive learning and click the "Recognize-Save" button.



I— % @ Recognize
| Leatn — Save

The OCR progress is indicated on-screen. You can click the "Stop" button to
abort the text recognition.

OCR in progress

At the end of the recognition, Readiris enters the interactive learning phase
when the learning is enabled with the "Learn" button on the main toolbar.

(Interactive learning does not apply to Asian documents: learning does not
make sense for these languages which use thousands of different symbols - and
you’d have to be able to enter the ideograms, not an easy task when using a
Western keyboard!)

Font training can substantially enhance the accuracy of the recognition sys-
tem. When the user tries to read distorted, defaced forms as are found in real
documents or stylized font shapes which Readiris does not recognize optimally,
training can overcome this temporary “failure”.

User learning is also used to train the system on special symbols which
Readiris is unable to recognize, such as mathematical and scientific symbols and
dingbats. Some examples: Readiris can be trained to recognize the "n" symbol as



2-39

USER s GUIDE

"pi" or the dingbat "&" as "Tel". (However, the list of recognized symbols cannot
be extended with the symbols "n"and "&"!)

The recognized text is displayed progressively and the system stops on doubt-
ful characters, or - if you are dealing with touching characters (“ligatures™) - on
doubtful character strings. They are always presented in their context, the doubt-
ful characters are highlighted. Unrecognized characters are represented by a
tilde (the "~" symbol).

New Dictionary: C:\My DocumentsiReadiris.dus

835

Learn

Don't learn

Delete

Undo

1885 -

Abort |

The first thing you should do is verify if you activated the correct font dictio-
nary and dictionary mode - these are always indicated in the title of the learning
window. If that is not the case, click the "Abort" button - the document image is
redisplayed with the zoning as was created -, enable the right font dictionary or
dictionary mode and run the OCR again. (The operation of font dictionaries will
be discussed shortly.)

If necessary, enter a character (or character string) for the incorrect or un-
known shape and click one of the following buttons.
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Learn

You agree with the proposed solution or correct it. The program saves this
doubtful character in the font dictionary as “sure”, final. Future recognition will

no longer require your intervention, the shape is considered learnt once and for
all.

In the example above, the system stops on a soiled character, and we click
"Learn" to accept a shape which cannot be confused with other characters.

Don’t Learn

You agree with the proposed solution or correct it. The difference with the
"Learn" button is that the learnt symbol gets the status “unsure” in the dictionary.
For future recognition, the system will propose the “learnt” solution but still re-
quire a confirmation.

This button is used for symbols which might be confused with others: a de-
faced "e" which might be mistaken for a "c", a damaged "t" which closely re-

sembles an "r" etc.

New Dictionary: C:\My DocumentsiReadiris.dus

Learn

Don't learn

Undo

Whitney-(8)-{(| __=

| B Abart |

Delete |
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The "¢" above is seriously damaged - in fact it is close to the "¢" symbol -, and
you should click "Don’t Learn" so as not to confuse the two symbols.

Delete

The displayed form is eliminated from the output. This button is used to ignore
“noise” on the documents - spots, coffee stains etc. - which might get recognized
as points, commas and what have you -, and to erase any other unwanted sym-
bol.

Undo

You go back to correct mistakes. You can undo the 32 last decisions.

Finish
The learning process is aborted but the OCR continues in automatic mode. All
decisions by the system thereafter are accepted without user validation.

Click this button when you see that the recognition is highly accurate and does
not require detailled proofreading.

Abort

Don’t confuse "Finish" with the "Abort" button: with "Abort", no output is
generated and you start all over, with "Finish", the text is created, it just isn’t
proofread in detail!

THE RoLE oF FoNT DICTIONARIES

The results of each training session are temporarily held in the computer’s
memory but can and should be stored in files called “dictionaries” for future use.

(Don’t confuse font dictionaries with lexicons! Font dictionaries contain char-
acter shapes learnt during the interactive OCR phase, lexicons are linguistic da-
tabases that assist the recognition.)
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The font dictionaries should be loaded into memory when you want to recog-
nize similar documents in order to make use of the extra intelligence they contain;
in this way, Readiris takes into account the intelligence stored in these font librar-
ies. You could say that Readiris gets more intelligence each time you use it!

How does this work? The operation of font dictionaries is controlled by the
"Learn" menu: you have to select a dictionary with the command "Font Dictio-
nary" and determine its mode of operation.

Dictionary

Look i |uDI My Documents ﬂ £ B9

@My Music
iﬂMy Pickures
@My Yideos

Readiris.dus

File name: |Headiris
Files of tppe: |Dictionary j ﬂ

* Mew Dictionany

" Append Dictionary
" Read Dictionary

Font dictionaries are limited to 500 shapes, and you are recommended to
create separate dictionaries for specific applications, for instance per type of
document. Dictionaries have the default extension *.pus. Training no longer has
effect when the dictionary is full: the results of the learning are no longer held in
memory or written to a dictionary.
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You can set the dictionary mode inside the command "Font Dictionary" or
directly under the "Learn" menu. Three dictionary modes are available: new,
append and read.

w [ew Fonk Dickionary
Append Font Dictionaty
Read Font Dickionary

v Interactive Learning

By selecting "New Font Dictionary", you indicate that the training results will
be saved in a new dictionary. (If you select an existing dictionary, its contents will
be erased.)

The append mode indicates that the training results will be saved in an existing
dictionary: the recognition makes use of the extra intelligence already contained
in the dictionary, and you add new font shapes to it. In simple terms, this option
allows you to build up a font dictionary in several steps.

(When you enter a file name for a new dictionary and activate the “append”
mode, an empty font dictionary is created and you complete it.)

With the last option, "Read Font Dictionary", the dictionary functions in read-
only mode: you make use of the dictionary wrthout adding new font shapes to it.

Select the new mode when a single page is recognized. To recognize many
pages of the same type - pages with the same fonts and printing quality - select
the new mode for the first page, the append mode for a few pages more and the
read mode for the rest of the document(s).

Know that the tooltip of the "Learn" button indicates at all times which font
dictionary is currently active and in which mode that dictionary operates.

1

L;@f;l

j%l.ﬂutomatic learning: C:\My DocumentsiReadivis. dus (Mew Dictionary)
= T
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When you enter the interactive learning, the dictionary and its operating mode
are indicated in the window title; you should click the "Abort" button and start
over in case they are wrong.

New Dictionary: C:\My Documents\Readiris.dus

m Learn |
Don't learm |

Delete |

Undao |

Darling -
| Em Abart |

SENDING RESULTS DIRECTLY TO YOUR APPLICATION

The interactive training concludes the character recognition. As Microsoft
Word operates as output target by default, your wordprocessor is started up au-
tomatically at the end of the recognition (if necessary) and the recognized text is
inserted.

You may get a progress bar on-screen as the recognized document gets for-
matted. (Whether this progress bar appears on-screen or not depends on the size
of the document and the complexity of the formatting to be performed.)
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Faormatting text

Stop

The scanned image is displayed again with the zoning as created to be avail-
able for further processing, it stays there until you scan another page.

You have indeed converted a paper document into an editable computer file,
be it 40 times faster than manual retyping! Go ahead and compare it with the
image you have inside your Readiris window.

Actually, Readiris offers three different methods when it comes to saving the
OCR result: sending the recognized document directly to a target application,
saving the result in an external file and copying the result to the Windows clip-
board.

The output target is selected using the "Format" button on the main toolbar
(or the command "Text Format" under the "Settings" menu).
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Text Format le
Output
* Sendto |Microsoft “Wwiord 97 /2000 /2002 4 2003 (RTF) j
™ External file | J
i
B
Layout

" Create body text
" Retain word and paragraph formatting

{* Recreate source document

[ Use columns instead of frames
-

™ Addimage as page backaground

Format [+ Include graphics

[ Retain colors of test %

I” Retain colors of background

I Options
IV Merge lines into paragraphs
I a_j“l g Fall Advanced...

FDF options
I~

-

0K | Caticel Help

The "Send to" feature offers a direct OCR link between your scanner and
your Windows applications: you send the scanned documents directly to your
wordprocessor, spreadsheet or web browser, to Adobe Reader etc.!
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Output

* Sendto Microsaft \wiord 97/ 2000 / 2002 / 2003 [RTF)

~ . Adobe Acrobat / Reader - Image-Test
Extemnal file Adobe Acrobat / Reader - Text
Adobe Acrobat / Reader - Test-lmage
r Clipbaard
Clipboard Microzaft Excel
I Corel WordPerfect
HTHL editar
Layout »rlﬂarle h; ool

icrozoft Exce
€ Create body text Microgoft Intermet Explorer
Microzaft 'word 2003
i [t Wwford 97 /.
* Recreate source document EE::;SEEE org Wwhiter 1.0, 1.1

: SoftwareB02 Pra PC Suite
[ Use columns instead ol Sun StarDffice E.0
r Sun StarQffice 7.0
"Web browser
WiordPad b

Kl

" Retain word and paragraph f

At the end of the recognition, the target application is started up and the rec-
ognized document is opened inside a new text file or worksheet.
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Pleaze wait while loading kicrozoft
Wiord 97 /4 2000 4 2002 ¢ 2003

Don’t forget that the option "Send to" also allows you to copy the recognized
text to the Windows clipboar d, so there is no strict need to export the result... or
save it to an external file!

SavING THE REsULTS IN A TEXT FILE

You can indeed write the OCR result to an “external” file. Here again, Readiris
supports a wide range of file formats incorporating all popular wordprocessors,
spreadsheets, web applications etc. (Amongst others, Readiris supports WordML,
the new text format of Microsoft Office 2003!)



Text Format
Output
" Sendta
* Euternal file

W Open after zaving
r

Layout
" Create body test

* Recreate source document

[ Use columns instead o

-

Options
[V Merge lines into paragraphs

[v Include graphics

[ Retain colors of text

FOF options
~

~

[ v |
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| ¥

|Microsoft Wwhord 97, 2000, 2002, 2003 [*.doc)

E

" Retain word and paragraph fd

D& [* dea)

Drizplayiarite [* di )

E-Press EaspOffice [*.1tf)

FlashPeak SlimBrowser 4.07 [* htm)

HTML [*.htmn)

Jarte 1w [*.0tf)

Lotus “wordPro [amiPro] (*.itf)

Macromedia Dreamweaver Mx B.1, Me 2004 [* htm)
Microzaft Excel (% cav)

Microzoft Excel (% htm)

Microgoft Excel tab. [*txt]

Microzaft FrontPage 2002, 2003 [* htm)

Microzoft Word 2.x [*.doc)

Microzaft Word 2003 [* sl

Microzoft word 4.0, 6.0, 7.0

Microzaft Wiord 57, 2000, 2002, 2003 [*.rtf)
Microzoft Works 4.5, 5.0, B.0 [*.wps]
Mozila Composer 1.4, 1.5 [* htm]

Mozilla Firefox 0.9 [ htm)

Mozilla Mavigator 1.4, 1.5 [*.htm)

Muiltibd ate [*.mm |

Metzcape Composzer 7.1 [ htm)

Metzcape Mavigator 7.8 [% htm)
Openffice.org Wriker 1.0 1.7 [*.rtf]

Opera B, 7 [*.htm)

RagTime [*.1tf)

Rapid Media Network RapidB rawser 5.0 [%.htm)
Rich Text Format [=.rtf]

RoughDiraft [*.1t)

SoftwareB0Z2 Pro PC Suite (%]

SOT Office Wiiter 2003 [*.rtf)

Sun StarQffice B.x [*.1tf)
I

&3

The option "Open after Saving" is largely similar to the “send” feature: you

open the recognized document once it’s saved.



COutput
™ Sendto | J
* Ewternal file Micrasoft word 97, 2000, 2002, 2003 (. doc) |

[v Open after saving
[ Send by e-mai

However, the method used to address the target application is different. This
time, the Windows file types determine which application will be started up.
It’s as if you double-clicked the output file in the Windows Explorer... (With the
option "Send to", Readiris addresses specific target applications directly.)

Folder Options

General | Wiew | File Tepes | Offling Files

Registered file types:

Extensions  File Types -
ﬁ DIF Microsoft Excel Data Interchange Format

ent -
DDCH... icrozoft Wword HTHL Diocument
%DDEM... DOCKHTHL File
DDT Micrazoft Word Template
DDTH... Microsoft Ward HTML Template

el s [¥H B Cavmnd ODD Dl filn ]

Mew ][ Delete ]

Detailz for 'DOC' extension

Opens with: Microsoft Word

Files with extenszion 'DOC" are of type ‘Microsoft Ward Docurment’.
To change zettings that affect all 'Microzaft \word Document! files,

click Advanced.

I 0K H Cancel ]
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The option "Send by E-mail" creates a new mail message and inserts the
recognized document as mail attachment. Do you know a faster way of distribut-
ing a paper document quickly...?

Cutput
(" Sendta | J
v Euternal file |Micmsuft WWard 97, 2000, 2002, 2003 [* doc) ﬂ

[ Open after zaving

v Send by e-mai

E® Scanned report with table - Message [Rich Text)

i Fle Edt ‘Wew Insett Format  Tools  Actions  Help
i Y -lALB L D=
iidsend | [ &4 £ 3 0% ] 2 1 THattach as Adoberor |G B | A 1B | ¥ |

Subject: |Scanned report with table |

document . doc
(15 KEB)

CREATING PorTABLE DOCUMENTS...

We’ll go deeper into one format: Adobe Acrobat PDF. Readiris allows you
to create text- and image-based PDF documents.



Output

{« Sendto

" External file

v
-

Layout

s

e

{* Recreate source document

r
-

Clutput
" Sendto
{* Euternal file
[v Open after zaving

[ Send by e-mail

Layout
{

o~

Adobe Acrobat / Reader - Image-Test j
e

X

- Image

- Image-T ext
Adobe Acrobat / Reader - Text
Adobe Acrobat / Reader - Texstlmage
Chpboard

Clipboard Microzoft Excel

Corel WordPerfect

HTHML editor

Jarte 1%

bicrosoft Excel

Microgaft Internet Explarer

Microzoft Word 2003 [wordhdL)
icrosoft Word 97 / 2000 / 2002 / 2003 [RTF)
Metscape

OpenOffice.arg Wwiter 1.0, 1.1

Softwarebl2 Pro PC Suite

Sun StarDffice 6.0

Sun StarDffice 7.0 ¥

|.f1‘-.|:lnbe acrobat POF Image [F pdf]

AbiSource Abiwiord [* rtf
Adobe Acrobat PDF Image [*.

3 RAER

Adobe Acrobat PDF Image-Test [*.pdf) k
Adobe Acrobat PDF Test [*.pdf]

Adobe Acrobat PDF Test-Image [*.pdf)
Adobe GolLive B, C5 [*htm]

Atlantiz Mova [*.1tf]

atlantiz Ooean Mind [0t

Awant Force Avant Browser 10.0 [ htm]
Corel wordPerfect 12 [*.rtf]

What’s the difference between these formats? When you select the format
"PDF Text", Readiris creates a PDF file that contains the text result. (Graphics
may occur but only when graphic zones occur on the page - photographs, art-
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work etc.) In other words: the page image is nof contained in the single-layered
PDF file! The format "PDF Image" is also single-layered, but it obviously only
contains the scanned image, no OCR results!



B 4 dobe Reader - [autoform. pdf] 5
EFiIe Edit  Wiew Document  Tools  Window  Help -9 x

ooy

@Open E [i::’!] % “ ]:’ESeledTe:d - ﬁ
[Jewr -o[DD

@ eBooks -

L
g uto Ol‘mattlng
=
=
-]
E The aim of "autoformatting” 13 to recreate a faczimils copy of
[==] OCF, moms dom mors (e just Tha warlaus l'f"]' f
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The formats "PDF Text-Image" and "PDF Image-Text" yield different results:
Readiris creates a searchable PDF file that contains the recognized text and the



USER s GUIDE

page image. With “text-image” PDF files, the text is placed above the page im-
age in the two-layered PDF file; with “image-text” PDF files, the text is con-
tained under the page image. Use the "Search" tool of Adobe Reader and this
becomes quickly obvious!

\@ Search PDF

Finished searching For:

game
Tokal instances found:
9
»
Resulks:

rou and Michael

Kl this game. Sounds pretty final. ¥eah,

Elthe game far a while. ¥ou

£l game, breaking opponents down. But

El hack games in an 82-game

Kl game season. He knows it,

B final game - what he did

Kl zeventh game of the World Series and

T of game tape together, weve argued,
B Dore

B Use Advanced Search Options
L@ Complete Acrobat 6.0 Help

PDF files of the type “text-image” are actually pretty sophisticated: the pixels
of the recognized text are erased to create a legible document! Displaying recog-
nized text in, say, black on top of black character bitmaps would give you text
with a heavy shadow... You can recognize the sample image



BACKGROUND.JPG if you want to give it a try. (Readiris Corporate offers the
same functionality for other text formats as well...)

One series of roses that has habits perfectly suited for
pots, is the small and medium growing hybrid musks.
They are perpetual shrubs with the pleasing quality
that in the course of their long flowering period new
and sometimes numerous ground shoots emerge from
their budding point (the bulge above the roots).

#2 Adobe Acrobat - [background. pdf]

i; File Edt Wew Document Tools Advanced Window Help
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L= ¢

All text-based PDF files encode web site URLs as visible links: click them to
visit the mentioned web site!
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The page analysis gets re-executed after the
deskewing.

Copyright TRIS
Web site:

it A, irislink. com

| 150,3% 296,7 mm

1of 1 o o

Click the "Format" button to discover some options that concern the Acrobat
PDF format: "Create Bookmarks" and "Embed Fonts".

PDF optionz
[v Create bookmarks

[+ Embed fonts

The option "Create Bookmarks" sees to it that a bookmark is created for
each document element - the graphics as well as the text blocks and tables. For
the text zones, Readiris applies an intelligent algorithm to come up with a title, a
“summary” per zone; the tables and graphics are simply numbered. (Another
navigational element of PDF documents, page thumbnails, can be created dy-
namically by your Adobe Reader software!)
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The option "Embed Fonts" embeds the fonts in the PDF files. Embedding
fonts prevents font substitution when readers view and print the recognized docu-
ment. It ensures that readers - whatever their computer configuration may be -
see the text in its original fonts. However, embedding fonts increases the file size

of the recognized documents (somewhat)!

A further option of PDF files is “hidden” under the advanced graphic options
in the "Format" dialog. When you generate PDF files, you can select the com-
pression method for the graphics inside PDF files - JPEG or JPEG 2000. JPEG

2000 is the newest, more compact version of the JPEG standard.)

Optiohz
’7|7 Merge ines inta paragraphs

Advanced..
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[ Black-and-white qraphics

% Retain scan resolution

™ Reduce resolution to: dpi
JPEG quality

least best
v JPEG 2000 compression

0k | Cancel

... OrR READING THEM

Let’s look the other way for a moment. As Readiris offers full support of the
Adobe Acrobat PDF format, you won'’t just generate PDF files, you can also
read them!

“Repurposing” PDF documents may be a major application of Readiris.
There are several reasons why this is the case. First of all, it’s a way of convert-
ing images into text: open image-based PDF documents, execute the recognition
and save the OCR result to a text document (in any supported text format). Text
files are editable, image files are not.

Second case: you can convert image-based PDF files to text-based PDF docu-
ments. You then execute the recognition on “image-only” PDF files and save the
OCR results... as text-based PDF documents! Text-based PDF files are search-
able and editable, “image-only” PDF files are not.



Finally, converting PDF files is a way of “unlocking” PDF content. You can
recognize “read-only” PDF documents, where the text is normally inaccessible.
With unprotected PDF files, the content can be retrieved (copied and saved to a
text file), with “read-only” files, the content cannot be extracted. These docu-
ments can only be viewed and printed!

Two important nuances must be noted: Readiris does not open password-
protected PDF documents, even if all other PDF security barriers are broken
down by Readiris! (To be specific: “master passwords™ that set the permissions
of PDF documents don’t bother Readiris, “user passwords™ required to open a
PDF document do.) Secondly, Readiris does not convert PDF documents that
contain JPEG 2000 compressed images.

Proceed as usual: load PDF files into memory as you open prescanned images
- faxes, snapshots made with your digital camera etc. Click the "Stop" button or
press Escape to interrupt the loading process between two pages.

There’s a specific option that concerns PDF files. You can open them as color
and as black-and-white documents. This option is offered because rasterizing
color documents is much slower!
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Look i |l‘f} Readirs j p ek E5-

T sample

File narme: |sam|:|le
Files of type: | PDF [*.pdf) -] Cancel

[v Load PDF documerts in color

[ Digital carnera
[~ Smoothen color images
[ Process as 300 dpi
Page range
" Al pages
+ Page: |1 to |E|

Secondly, you may want to indicate which pages you want to convert. If your
objective is, say, to capture just a chapter of a lengthy PDF publication, it doesn’t
make any sense to load the entire book into Readiris... Indicating the proper
page range can save you lots of time! (This also holds for multipage TIFF
images.)



REecocNizING MULTIPLE PAGES

After the OCR, the scanned image is redisplayed with the zoning as created
to be available for further processing.

You can now open the recognized text with your wordprocessor or text editor,
import it into your desktop publishing software or any other text-based applica-
tion. Go ahead and compare it with the image you have inside your Readiris
window.

But how do you save the text of additional pages? Or in other words: how do
you process documents consisting of multiple pages? It’s actually very simple: go
on recognizing pages and save the results to the same file! (Make sure that file
isnt currently open, because that will prevent you from writing to it!) Secondly,
don’t forget to put the font dictionary in the append mode so that you can con-
tinue the font training comfortably.

As soon as you scan pages (or open image files) inside a document, you have
to decide whether you want to start a new document or complete the current
document.

Readiris

Are you ready bo delete the current docurnent?

es Mo Cancel ‘

Answer "no" to add pages to the current document, answer "yes" to create a
new document. This answer has the same effect as the command "New Docu-
ment" under the "File" menu.

Mew Docurment Chrl+m

However, there’s a more efficient way of recognizing several pages than scan-
ning and OCRing them one after the other: processing multipage documents
directly!
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To scan a document composed of several pages in one operation, enable the
document feeder of your scanner with the option "ADF" under the "Scanner"
button.

[ Landscape
v ADF
= [ Irvvert
gﬁ [ Digital camera
Scanner [ Process as 300 dpi
[ Smoothen color images

Place the pages of your document in the automatic document feeder and start
the scanning: all pages are scanned until the document feeder is empty.

When your flatbed scanner is not equipped with a document feeder, interval
scanning allows you to scan multipage documents efficiently. The scanner auto-
matically scans another page after a user-selected number of seconds; the inter-
val allows you to replace the page you put on your scanner’s flatbed.

Indicate the interval you need to place another page on the scanner’s flatbed
in the scanner settings; click the "Scanner" button and define an appropriate value
for the option "Scan Another Page after x Second(s)".



Tupe
= [
Scanner Model... ‘ Cancel
Canfigure. . ‘
Resolution:
Contrast 0 00 -
)
Brightness i ¢ Black-andwhite [~
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darken lighten ¢ Colar [ Invert
. ) [ Digital camera
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Click the "Scan" button to initiate the scanning. Click "Abort" in the interval
scanning dialog to end the automatic scanning.

Interval scanning

The next page will be zcanned
in 2 zecond(s]

g Scan Pause
Scan now | Ahaort |

Readiris offers full flexibility: you can bypass the scanning interval to scan
instantly and freeze it to take a phone call! Click "Pause" in the automatic scan-
ning dialog to freeze the scanning interval; click "Resume" when you’re ready to
continue. Or click "Scan Now" in the interval scanning dialog to scan immedi-
ately: the interval is cut short!
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You can also openmultiple prescanned images. To load several images, select
the first image and hold down the Ctrl key as you select additional images. To
load a continuous range of images, select the first image and hold down the Shift
key as you select the last image.

Loak, ir: J 15 Readiis _:j =5 B2~
|E] deshew [ greek: i) mutipag 8-
asian Ltj digital Ltj italian Ltj norweg Ltjt

Ltj dutch Liﬂ japanese Ltj polish Liﬂ t
Lt_j brazil Liﬂ korean Ltj russian

|9 catalan &5 French [&] e &) simp-chinese
‘ ‘ Ltj czech Ltj german Liﬂ ki Ltj spanish
2
: < | >

File name: 1"english.ipg" "alphabet tF* " autafarm.jpg'” Open I
Files of tupe: ]AII image files _:j Cancel 1

The same effect can be obtained comfortably from within the Windows Ex-
plorer: select several image files, right-click and select the command "Recognize"
from the "Context" menu. You can repeat this operation: all images you send to
Readiris append the current document until you click the command "New Docu-
ment".
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You can even drag several prescanned images from the Windows Explorer
onto the Readiris window! The same argument holds: all images you drag onto
the Readiris window are added to the current document until you click the com-

mand "New Document".

Readiris sorts the images automatically - image 001.tif precedes 002.tif pre-

cedes 003.tif etc.

The document panel displays statistics and information on all scanned
pages - the image source and resolution, the scanning and recognition time etc.
The document panel can be hidden and displayed with the corresponding option

under the "View" menu.
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o,

You also learn which image was loaded into memory. If a multipage image
was opened, there’s obviously just one file for all the images. When you are
scanning, the document panel simply mentions the scanner model.

Page | Image source | Scan kime | OCR time | Resolution | ‘Width | Height | Lineskew | Rotation  #
[ ultipage.tf - 2,74 - 2000 o

2 C\Program Files\Readiris\multipage.tf - 2.08 - 300 2000 1833 - - E
3 C\Program Files\Readirisimultipage. bf - 2.05 - =00 1912 2004 - - w

Drag the column resizing cursor to change the size of a column. (You cannot
change the order of the columns.) Or hold your mouse cursor over a column
when it is too short to display the data: a tooltip will display the full data!

Page | Image source | 3can time |

C:'l,Program Files\Readiris\enaglish.jpg -

| Image source q.l,Scan tirne |

Ci\Program Filest... 3.07

You can display the same information for all pages with the command "Info"
under the "File" menu and you can display that information per page by holding
your mouse cursor over a page thumbnail in the page toolbar on the left side.
This toolbar is displayed as soon as pages get processed. It gives access to the
page commands (using the right-click).

mage sounce Lo A Bt ]
Image source C\Program Files\Readirisienglish. jpg |

Scan kime §.52 seconds 5 Select Page

CZR time - Delete Page
Resolution 300 dpi Mowe Pans |

Width 2245 pixels

Height 2541 pixels

Lingskew -

Rotation =




The current page is highlighted in the document panel and page toolbar and
mentioned in the Readiris title bar.

To delete a page, select it in the document panel and press the Delete key! (Or
select it in the page toolbar, right-click it and select the command "Delete Page"
from the "Context" menu.)

You can quickly print the scanned images with the "Print" button on the
image toolbar (or with the command "Print Images" under the "File" menu) should
you need an overview of your document.

-1l

Print Images... Zkr[+P

You can print the current page or all pages. Select the number of pages or
thumbnails you want printed on a page.

Print Images rg|

" Cumrent page

* &l pages

Images per page:

64 -

(] | Cancel

But you don’t have to print all pages either: the document panel (and the
corresponding commands in the "Edit" menu and the contextual page commands



USER s GUIDE

of the page toolbar) allow you to exclude pages (temporarily). Simply click the
page number in the document panel to exclude it from the printing (and recogni-
tion) process. Click a second time to include it again. For greater flexibility, the
"Edit" menu offers equivalent commands that apply to a//pages.

Page |Image SOUFCE |Scan time | M
()1 Ci\Program Files\Readiris...  0.94

z C\Program Files\Readiris,.. 0,71 Include All Pages
3 C\Program FilesiReaditis,..  0.73 Exclude All Pages

The thumbnails of excluded pages are stricken out. Mind you, printing the
current page always works, even if it is “disabled” for the time being!

1
P

Load the sample image MULTIPAGE.TIF and start the recognition. The vari-
ous pages are displayed one after the other; the Readiris title bar indicates the
page number.
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m Image source Scan kme QCR time: Resolution Width Height Lineskew ~
2z C\Program Filesl... 1.39 1.62 300 2000 1588 e
3 CiProgram Filesl... 1,35 2,10 300 1912 2004 - |
4 C\Program Files\... 1.49 300 2004 2000 3

L ElxY

If the interactive learning is enabled, you go through the recognition and learn-
ing phases page by page. The dictionary mode "New" is used for the first page

and the mode "Append" for the successive pages.

When you click the "Finish" button, all decisions by the system thereafter are
accepted without user validation. In other words, the interactive learning is aborted
for all pages; the OCR for this document continues in automatic mode.
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The recognition result of multipage documents is saved in a single output file.
(When the recognition result is sent to a target application, multiple pages get
created inside a single document.)

At least, that’s the case when the option "Create One File per Page" is dis-
abled when you save the recognized document. This option sees to it that each
page of a multipage document is saved in a separate file. If the user gives the file
name text.doc, the files will be called text-1.doc, text-2.doc etc. (This option is
not available when you send the OCR results to a target application, only when
you create an external file.)

File name: |mu|li|:lage
Save az ype: |F|ich Test Format j %

[ Open after saving

[ Send by e-mail

[¥ Create one file per page
[multipage-1, multipage-2..]

EDITING MULTIPAGE DOCUMENTS

The user can edit multipage documents, mainly to correct scanning errors: he
can delete pages from the document and move pages to other locations in the
document.

The navigation first. To go fo a page, click it in the document panel or in the
page toolbar. (Or hold your cursor over its thumbnail, invoke the "Context" menu
by right-clicking and use the command "Select Page".) To go to the previous
page, you can use the shortcut PageUp, to go to the next page, press PageDn.
Press Home to go to the first page. press End to go to the last page. Or use the
corresponding commands under the "View" menu.



Prewvious Page [! Pagelp

Mexk Page Pagelown
Last Page End

Let’s edit the document now. To delete a page, select it in the document panel
and press the Delete key. Or hold your cursor over its thumbnail, right-click it and
select the command "Delete Page" from the "Context" menu.

?

Exchude Page 1

———  MovePage1 Up k

Mowe Page 1 Down
B |

And we remind that you can temporarily exclude pages, not delete them, from
the recognition (and image printing) process: the document panel, the page toolbar
and the "Edit" menu offer the necessary commands.

Enl e
AT

Delete Page 1

Page | Source Scan time |
O: C\Docume...  5.68 1
Flz cipocume.,., 9.45

Move Page 1 Down

To move a page up in the document, use the command "Move Page Up", and
to move a page down, use the command "Move Page Down".

To move a pageto a totally different location in the document, drag its icon to
that new location.
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STARTING A NEw DOCUMENT

You can use the command "New Document" under the "File" menu to close
the current document.

Jocument ChrlHM

This command “cleans the slate”. Any document loaded into memory - con-
taining a single page or multiple pages - is erased. You are now ready to create a
new document.



But you can also create a new document from within the current document.
As long as the OCR was not executed, the system assumes that you want to add
pages to the current document. You can for instance scan all the pages in the
scanner’s autofeeder, fill the feeder again and start over. All pages scanned will
compose a single document. Or you could scan a number of pages and add some
image files, say, faxes. These pages again form a single document, all you have to
do is change the image source in between with the "Source" button.

When the OCR was already executed and you re-initiate the scanning (or the

loading of images), you are prompted to start a new document or complete the
current document.

Readiris

Are vou ready to delete the current document?

Yes Mo | Cancel |

REecocNizING TEXT ZONES

We now know how to recognize pages and how to process multipage docu-
ments. But can we recognize less than a page with equal comfort? We can!
Right-click your mouse and select the command "Copy as Text" from the "Con-
text" menu: the text window under the mouse gets recognized and sent to the
clipboard.
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is to recreate a facsimile copy of

The various levels of
formatting are: creating body
text, retaining the word and
paragraph formatting and
creating a facsimile copv.
fagnifying Glass

Creating body tHE
formatting is g e
get a COﬂtinuou Window 3
text. All formatting, if
any, is done afterwards by
the user.

If you retain the word and paragraph formatting,
the font type, size and typestyle are maintained
across the recognition. The justification of the
paragraphs is also detected. However, no graphics
are captured and the columns aren’t recreated -
the paragraph just follow each other etc.

“Autoformatting” recreates a facsimile
copy of the original document: the text
blocks, graphics and tables are recreated in
the same place and the word and
paragraph formatting are maintained
across the recognition.

The current system settings - language, font type etc. - apply. The OCR result
is placed on the clipboard as “running”, unformatted text.



ORGANIZING THE TEXT OUuTPUT

Saving or exporting the text means more than selecting an output method or
defining a file name for the output file. You also select a file format and determine
the appearance of the recognized text. In short, you have to decide where you
want to take the text before you launch the execution.

Some options of the "Format" button allow you to influence the look of the text
output.

The text flow of the output document is directly influenced by the option
"Merge Lines into Paragraphs".

Optionz
v tderge lines into paragraphs

¥ |nclude graphics

Keep this option enabled to have Readiris detect the paragraphs: Readiris will
then apply the normal wordwrap typical of wordprocessors, otherwise, a car-
riage return is added after each line and hyphenated words remain so! Paragraph
detection is enabled by default.

Let’s give an example to clear things up. When the first three lines of a col-
umn are "The new presi-", "dent waved from the balcony." and "His wife had
joined him.", the paragraph detection gives you the following result: "The new
president waved from the balcony. His wife had joined him." The hyphenated
parts of the word "president" were “reglued” and a space was added at the end
of the first sentence, thus creating naturally flowing text.

Had paragraph detection nof been enabled, the original layout would have
been retained, with a carriage return added at the end of each line.

This option is not available when the PDF format is selected: Adobe Acrobat
PDF files always store text line by line!

(The "Format" button contains some formatting options we haven’t discussed
yet - this will be done shortly.)
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SETTING UP YOUR SCANNER

Let’s set our scanner up now. It is assumed that the scanner hardware and
necessary drivers are installed correctly.

If your Readiris software licence was bundled with a scanner or digital cam-
era, this step probably is unnecessary as your hardware may already be set up
under Readiris.

Click the "Scanner" button on the main toolbar.

| =

Scanner

Click the button "Scanner Model" to determine your scanner model.

Type

Format:
HP <ather madels> [TWiIN] o oK
A4
Scanner Model... | Cancel

Configure. . |
Fezolution:

Contrast a 300 -

!
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Brightness 1] * Black-and-white [

} " Grepscale r
darken lighten ¢ Calor [ Invert

. : [ Digital camera

v Optimize rezalution for JCR W s e 000

W Scan anaother page after |10 3: zecond(s) [ Smoothen color images




When you select the option "<Image>" as “scanner”, prescanned images func-
tion as image source at all times - you won’t have even to select the disk as image
source with the "Source" button on the main toolbar.

The "Configure" button is only available when you scanner allows it. It gives
access to some advanced scanning parameters; with Twain scanners, clicking
the "Configure" button allows you to select the Twain source. (You can also use
the command "Select Source" under the "File" menu.)

Select Source El

Sources:

Hewlett-Packard Scandet FE50
IBCR I 20

Cancel

Once the scanner is selected, the same window may allow you to set the
scanning resolution, the page format and orientation, brightness and contrast and
may allow you to indicate whether you are going to use the scanner’s document
feeder. With Twain compliant scanners, all scanning parameters are often set
inside the Twain interface.

Set the brightness, and, if available, the contrast.

By enabling the option "Landscape", you indicate that the selected page orien-
tation is wide (“landscape™) instead of tall (““portrait™). The page orientation actu-
ally applies to reduced page formats: on an A4 flatbed scanner, you can scan, say,
A5 pages (half that big) in portrait or landscape format, but you can obviously
only scan the full A4 surface in one direction!
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The option "Invert" allows you to generate “inverted” images in the black-
and-white scanning mode - you can activate this option to process full pages with
white text on a black background.

Interval scanning we already discussed. It is highly efficient way of scanning
multipage documents when your flatbed scanner is not equipped with a document
feeder.

LeT THE BAD CoLor NoTt BE SEEN

Readiris supports black-and-white, greyscale and color images on an equal
basis, so you are free to choose the color mode that best suits your needs. To
include lineart graphics in the recognized documents, scan in black-and-white, to
include black-and-white photos, scan in greyscales, to include color pictures, scan
in color.

But why would you reduce the bit depth of the images during the scan? It goes
without saying that greyscale and color images are slower to acquire and require
more RAM memory than “bilevel” images.

Scanning in greyscale and color isn’t just useful to save the graphics with
sufficient quality, in some instances, it’s also useful or necessary to obtain good
OCR results! When text is printed on a color background, scanning in color may
create the tone differences that are lacking in black-and-white images. When
there is only limited contrast between the text and the background, the back-
ground can create “noise” that renders the recognition difficult or impossible!

Think for instance of black text printed on a dark background: when scanning
such a document in black-and-white, you may not be able to “drop” the back-



ground color without losing the text information as well, as much as you may try

to adjust the scanner brightness...
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Readiris creates a black-and-white version for every greyscale and color im-
age. Thanks to its intelligent routines, even tough cases get solved - here’s how a
“difficult” image gets binarized!
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To view a scanned image in black-and-white, disable the option "Display Docu-
ment in Color" under the "View" menu.

w Display Docurnent in Color Crrl+-0
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Actually, you won’t see any black-and-white images on your computer screen
- even when you’re indeed scanning bilevel images! That’s because Readiris
optimizes the images for an optimal on-screen legibility. LR.1.S.” specialized high-
resolution display technique converts black-and-white images into greyscale im-
ages.

Reading dot matrix documents

You can read dot matrix document without changing the font mode. The software detects
whether “normal® text or dot matrix printouts are being read.

fFar out  in the uncharted backwaters of the unfashionable end of
the Western Spiral arm of the BGalaxy lies a small unregarded
vellow sur. drbiting this at & distance of roughly ninety~twa
million mites is an  witterly insignificant little blus gresen

Reading dot matrix documents

You can read dot matrix document without changing the font mode. The software detects
whether “normal” text or dot matrix printouts are being read.

Far out in the wuncharted backwaters of the unfashionable end of
the Western Spiral arm of the Galaxy 1lies a small unregarded
vellow sun. Orbiting this at a distance of roughly ninety—-two
million miles is an wutterly insignificant 1little blue green

Greyscale and color images are softened, smoothened.

A word about OCR

The ainm of OCR is to automatically enter prinled text documents in a very effective and
low cost way. Although the first research and development on Optical Characler
Recognition ((M'R) began more than 30 years ago, this technology is still unknown by
st of the people whe could usce it for their docament entry applications.



A word about OCR

The aim of OCR is to automatically enter printed text documents in a very effective and
low cost way. Although the first research and development on Optical Character
Recognition (OCR) began more than 30 years ago, this technology is still unknown by
most of the people who could use it for their document entry applications.

As a result, there’s no need to zoom in, even on laptops with an LCD screen
or desktop computers with a low-end 15 screen.

Zoom in at real size (or higher) to see the “raw” image as it was scanned!

DiFFerReNT DEevices, DIFFERENT RESOLUTION

Whatever your scanning mode may be, use a scanning resolution of 300 dpi
for normal applications. Use a higher resolution of 400 dpi for small print (below
10 point) and when the document is very degraded.

Readiris reads point sizesof 6 to 72 point (0.08” to 1 or 0.21 to 2.54 cm).

6 point

72 point

Readiris also recognizes “drop letters”, large caps that cover several lines.
(These can of course be no bigger than 72 point!) Even inverted drops caps gets
recognized...
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cover several lines and d e t
assigns them to their starting emlere_s Sec’ 1018.
line. Cette semaine, c’est la branche

As optimal OCR requires a resolution between 300 and 400 dpi, Readiris
warns you when you’re submitting images with a resolution lower than 200 dpi or
higher than 800 dpi. Amongst others, the image resolution of such images is marked
in red in the document panel.

Page | Irage source | Scan kime | CCR kimne | Resolution | Width | Height:
(™1 C\Documents and... 1,24 400

Readiris can correct scans with too much detail for you! Enable the option
"Optimize Resolution for OCR" in the scan settings to do so. Whenever the im-
age resolution of your scans exceeds 600 dpi, the resolution is reduced for the
OCR process.

[v¥ Optimize resolution for OCR
[ Scan another page after ({0 3: zecond(s]

There are other ways of avoiding this warning: you may be reading faxes -
which have a resolution of 100 or 200 dpi -, when you’re creating images with a
digital camera - where the resolution is unknown - and when you’re opening
images where the file header contains an incorrect resolution. To process such
images hassle-free, enable the option "Process as 300 dpi". This setting applies to
both direct scanning and the opening of prescanned images.

[ lrweert [ Load PDF documents in color
[ Digital camera [ Digital camera
v Process a5 300 dpi [ Smoothen color images

| Smoothen color images Mo A




When your images are acquired by a digital camera instead of a scanner, it
is mandatory that you enable a special option (that also applies to scans and
prescanned images).

™ Invert ™ Load PDF dacuments in color
W Digital camera ¥ Digital camera

¥ Process as 300 dpi ™ Smoothen color images

I Smoothen color images W Frocess as 300 dpi

By doing this, you enhance the image before it gets recognized. There are
specific challenges to be met when it comes to digital cameras: they produce
low-resolution images - even when you hold the camera very close over your
document - and the image resolution is in any case unkown.

There are some “finer points™ to be aware of when it comes to successfully
recognizing images captured with a digital camera.

First of all, select the highest possible image resolution. Create for instance
2,048 x 1,536 size images when 1,024 x 768 and 640 x 480 images are also
supported. Secondly, enable the “macro” mode of your camera to take closeups
- which is always the case when you photograph documents. (This mode was
designed to capture flowers, insects etc.) Otherwise, the images are unsharp and
illegible.
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Limit yourself to no or small compression: important compression reduces the
sharpness of the captured text. Zoom manually to crop your document - some
cameras are bundled with photo stitching software, but don’t bother using it for
document capture.

Hold the camera directly above the document to avoid capturing the docu-
ment at an angle. However, avoid shadows cast on the document by the camera
or your hand! Produce stable images. Consider mounting your camera on a tripod
when necessary.

Disable the flash when you’re filming glossy paper, otherwise the image may
be too light. Generally speaking, adapt the brightness and contrast to the environ-
ment - day light, lamp light, neon light etc. (Some cameras can be calibrated by
filming a white document.)

To give it a try, open the image DIGITAL.JPG in the Readiris folder and
execute the recognition.
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SavING DEFAULT SETTINGS

Set all scanning parameters correctly and click the command "Save Default
Settings" under the "File" menu to save the current settings as default settings for
future use.

vefault Settings




2-87

USER s GUIDE

Settings files contain more than the scanner settings: they also determine
whether you are going to use interactive learning, which language the documents
have, which output mode is used - for instance send text to WordPad - etc. In
short, a/l operational settings of Readiris are stored in the settings files.

SAVING SPECIFIC SETTINGS

The default settings will obviously be used at each program startup, but you
can save specific settings as well to avoid having to redefine the operational
parameters. The commands "Save Settings" and "Load Settings" under the "File"

menu take care of this.
Save Settings. .. !

Save Defaulk Settings

Let’s give an example: if you regularly have to OCR English documents with
a specific layout, you are recommended to create a settings file for this type of
document. You would then select "English" as the document language, load a
specific zoning template to avoid having to reapply the same windowing each
time, disable learning but activate a font dictionary in the “read” mode because
the same typefaces are used systematically etc.

If you are unsure what the current settings are, you don’t have to “plunge”
into every menu and command to discover what they are. You can use the com-
mand "Info" from the "File" menu to get an overview.



Information on settings

Scanner
b odel HF Scandet BRO0C
Fesalution 300 dpi
Farmnat Ad Text
E"g':‘”et“ g Farmat Micrasoft word 57 # 2000 / 2002 / 2003
WALIEE . FParagraph  On
Mod= Black-and-white Layout Fecreate source document
Landscape  OfF

Document
Fort Type Atonnatic Language  English

Fage

Page... | Image source | Scan time | OCR time | Resolution | Width | Height | Lineskew

C:vProgram... 385 - a7 ]

This command also displays the information you find on the document panel
for all pages.

ScaANNING DOCUMENTS

Now that our scanner is set up, we want to get started scanning documents.
There are some elements you should be aware of.

First of all, pay some attention to lineskew. Although the page analysis and
recognition are skew-tolerant, it may become difficult to window and OCR a
page correctly when the skew is too significant. Limited lineskew (less than 0.5°)
can be ignored because the OCR accuracy does not suffer.

The option "Page Deskewing" under the "Options" button (and under the "Set-
tings" menu) determines whether pages which were scanned at an angle will be
deskewed, straightened automatically - limited lineskew gets ignored. This op-
tion is disabled by default.
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| Page Deskewing

If you forgot to enable this option, use the "Deskew Page" button on the image
toolbar (or the command "Deskew Page" under the "Process" menu) to
“straighten” pages which were scanned at an angle.

The deskewing takes a few seconds: the image is analyzed to detect the skew
angle - if any -, the color or greyscale image andits black-and-white version are
deskewed and the page analysis gets re-executed.

You may also need to adjust the page orientation. Use the rotation tools on
the image toolbar. (Corresponding commands are found under the "View" menu.)
Three rotation directions are available: to the left, to the right and upside down.

Rotation also takes a few seconds as the image itself is updated, not just the
display on-screen.

@1 R e—

ﬁ Turn Upside Diown

However, Readiris can correct badly oriented pages for you. Enable the op-
tion "Detect Page Orientation" under the "Options" button (or under the "Set-
tings" menu) and Readiris will correct the page orientation where needed.



Jrienkakion

I Optluns

You can make good use of the image DESKEW.JPG in the Readiris folder if
you want to try it. Enable the options "Page Deskewing" and "Detect Page Ori-
entation" before you open the image and let Readiris restore the Tower of Pisa
the way we like it.
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Also note that the document panel indicates which skew angle was corrected
and which rotation was executed!

[ width | Height | Lineskew | Rotation
173 114 5.69° turned upside down

ADJUSTING THE SCANNED IMAGES

As was already indicated, powerful intelligent routines automatically convert
color and greyscale images into black-and-white. Should this still be necessary,
the user can optimize the image further for the consecutive OCR process. Select
the command "Adjust Image" under the "Process" menu to do so.

adjust Image. .. Ctrl+]

When you access this command, the black-and-white version is displayed
automatically. (It’s as if you disabled the option "Display Document in Color"!)
There are some complicated concepts here, and we need to discuss them in
detail.



Adjust Image

v Smoothen color image

With zome scanner models, reduction of the
sharphess is heeded to recognize color and
greyscale images.

Smoathening allows to separate the text from the
colored background Ok
C |
Brightness s
128
| Apply

J
lighten darken
Contrast
215
Help
o high
Despeckle; off
|
J
1] 20

The option "Smoothen Color Image" renders greyscale and color images more
homogeneous by “flattening”, smoothing out relative differences in intensity. As a
result, a stronger contrast is created between the foreground - the text - and the
background - a color, artwork etc.

This preprocessing feature may seem highly technical and difficult to un-
derstand, but it certainly has its role to play: with some scanner models, this
reduction of the sharpness is needed to recognize color and greyscale images.
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Smoothening is sometimes the only way separate text from the colored back-
ground! Below is a sample image that is simply illegible without image smoothing.

IN QUEST OF CALYPSO
from only £1,650.*
16 nights. 9th - 25th Oct 2000.

The image smoothening can also be enabled when you load prescanned im-
ages into memory!

Files of type: | Allimage files

[™ Load POF documents in color
[ Digital camera

v Smoaothen color images

[~ Process as 300 dpi

The brightness now. This setting determines the overall brightness of the
image: any darkening or lightening of the image applies to all pixels. The objective
is to rid yourself of the page background. We’ll give two examples. In the first
example, every zone of the image is dark. We therefore lighten the image to
eliminate the page background. The foreground - the text - remains sufficiently
dark to get detected by the binarization. Example 2: the image is so light even the



foreground text doesn’t show up in the binarized image! We darken the image so
as to make the text legible.

v i kazdego

NI A R LA Y £ 3

Verenigde Staten, .. .
+ wyjscia kazde

een antwoord te vi Jjscrat dego

maarmetnameor 27awia, ze nasze

The contrast determines the local contrast between the darker and lighter
zones of the image. (The text is usually darker than the background - the reverse
is true when you’re dealing with inverted text.) The objective is to make the
character shapes stand out nicely against their (colored) background. Here’s an
example where we need to increase because the default setting yields broken
characters.

A Look at International
Planning the Fufure ...

A Look at Tnternational
Planning the Future......

Note above all that no image adjustment is executed until you click the "Ap-
ply" button! By clicking "OK", you execute the adjustment and close the window.
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Here’s an example where we lightened the black-and-white image dramatically -
though admittedly not with OCR accuracy in mind!

| fa——

[v Smoothen colar image
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These options concern color and greyscale images, the last one, "Despeckle”,
exclusively concerns black-and-white images. “Despeckling” means that the “para-

site pixels™ (also called “salt and pepper noise™) will be removed from black-and-
white images.



mpic Games
The Olympic Games

Be sure that you don’t erase spots that are too big, otherwise you might start
erasing the dots on "i", portions of dot matrix letters etc.!

Dezpeckle: remove 10 pixel dots

[
J
i 20
Remaving too large dots may erase useful
infarmation fram the image

The best way of optimizing the images for the OCR process is this: place the
adjustment window where it doesn’t prevent you from judging the image adjust-
ment you execute. Adapt the parameters - clicking "Apply" each time - until the
image is crisp and clear.

LetTING THE OCR WizAarRD WORK FOR YoOU

Let’s get started capturing documents now. Instead of going through all the
parameters, we’ll use the OCR wizard, a very comfortable way of recognizing
pages.

Click the "OCR Wizard" button on the main toolbar (or select the command
"OCR Wizard" under the "Process" menu).

L Wizard...  Crrl+D

The wizard guides you through the OCR process comfortably: answer a few
simple questions and you’ll obtain quick and easy results with Readiris.
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OCR Wizard 3

The OCR wizard leads pou through the OCR process
comfortably,

Juszt anzwer these questions and pou'll get quick rezultz with
Readinis.

Click Mext to begin.

v Enahble ‘Wizard on Startup

| Mewt » | Cancel |

Actually, the OCR wizard starts running each time you start up Readiris; you
can avoid this by disabling the option "Enable Wizard on Startup" in the first
screen of the wizard (and with the equivalent option under the "Settings" menu).

REeADIRIS RECREATES YouUR DocuUMENT LAvyouT

The OCR wizard renders the recognition process highly automatic, but “auto-
matic” OCR should notbe confused with autoformatting! ““Autoformatting” means
that Readiris recreates a facsimile copy of the scanned document: the word,
paragraph and page formatting of your original document are applied.

Similar typefaces (serif and sans serif, proportional and fixed, normal and
condensed) are used as in the source document, the point sizes and typestyles
(bold, italic, underlined, superscript and subscript) are maintained across the rec-
ognition. The tabs and the alignment (left, centered, right and justified) of each



text block are recreated. So are the bulleted and numbered lists. Any e-mail
adresses and URLs of web pages get detected and recreated as hyperlinks in the
output. The placement of columns, text blocks and graphics follows your original
document.

In other words, Readiris allows you to archive a true copy of your documents,
be it a editable and compact text file instead of a scanned image!

All this implies that the sorting of windows only partially applies when
“autoformatting” is used: you can include and exclude zones, but any re-ordering
of zones is simply ignored!

Here’s an example of how it works. To get acquainted with this feature, open
the image AUTOFORMAT.JPG which is found in your Readiris folder.
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i Readirjis - o=11E3
File Edit Settings Yiew Process Learn Register Help
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In a way, text recognition is becoming Creating body text means no
maore and more page recognition or document formatting is applied: you
recognition... get a continuous, running
text. All formatting, if
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‘Whether your OCR sofiware reformats the user.

Options
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format it yourself, and you can recreate the acress the recognition. The justification of the
§ ) source document, including its formatting. paragraphs i also detected. However, no graphics
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Save the paragraph just follow each other ete.
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blocks, graphics and tables are recreated in
the same place and the word and
across the recognition.
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As a result, you get a true copy of your source
document, be it a compact and editable text
file, no longer a scanned image of your
document!

Copyriahs Taage Aessgnition fussmied Iy

[ Fage | Inagesowce | Scantime | OCRUme | Resolution | width | Height | Lineskaw__| Rotated |

2110 2615 0.00%

L el Y

Click the "Format" button on the main toolbar and choose to send the OCR
result to Microsoft Word or select the RTF (Rich Text Format) or Word (*.doc)
format. Secondly, select "Recreate Source Document" as layout option. (The
option "Merge Lines into Paragraphs" is enabled by default to apply wordwrap
within the paragraphs.)
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" Create body text

(" Retain word and paragraph farmatting

% Recreate source document

[v Use columns instead of frames

[v Insert column breaks

Whether layout reconstruction is available depends on the selected output
mode. Some “poor” formats generating “plain” text such as Text (ANSI), MS-
DOS Text (ASCII) etc. do not support advanced formatting codes and therefore
cannot offer autoformatting. The Adobe Acrobat PDF format on the other hand
was designed to copy the look of your documents: PDF documents by nature
imply autoformatting.

When the recognized text is opened using a wordprocessor, the text looks like
this without any intervention by the user.
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O autoform - Microsoft Word
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To see the effect correctly, you need to enable the “WYSIWIG”™ mode of
your wordprocessor, mostly called “page layout” mode. However, if you send the
recognized document directly to Microsoft Word, the page or print layout view is
activated automatically!
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In short, Readiris not only recognizes your texts, but can format them for you
as well. OCR isn’t just text recognition anymore, it has become document rec-
ognition as well!

L] &

CorLumns PLease, NoT FrRamES!

The formatting option "Use Columns instead of Frames" determines Aow the
“autoformatting” gets done: the text blocks, tables and graphics can either be
stored in frames or in editable columns.

Laypout
" Create body text

(" Retain word and paragraph farmatting

% Recreate source document

Iv Use columns instead of frames

[v Insert column breaks

“Frames” are separate containers for text used to position several blocks of
text, graphics and tables on a page. With columns, the text flows naturally from
one column to the next, and columnized texts are much easier to edit.

We now assume that real columns do occur on the scanned document: when
the system is unable to detect columns in the source document, this formatting
mode uses frames anyway as a “fallback™ position!
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You can make good use of the image COLUMNS.JPG in the Readiris folder
if you want to try it.

T columns - Microsoft Word
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it to look like a highly polished fili that told

"We had no money to start
with at all, so we thought if we
could at least raise money for

one day, that would give us
leverage to get the second day

REC| TRE| EXT | ©YR |French (Fra

The option "Insert Column Breaks" refines the recreation of columns: it deter-
mines whether you insert “hard” column breaks at the end of each column or not.
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With column breaks, any text you edit, add or remove remains inside its column;
no text ever flows automatically across a column break. All text that follows a
column break is moved to the top of the next column!

Enable this option when you want to maintain column breaks where these
were detected in the recognized document - whatever text editing gets done after
the OCR. In newspapers and magazines, the various columns on a page often
correspond to different article “threads”. Having text flow from one column to
the next “on the sly”, covertly may not be a good idea!

Disable this option when you have columnized body text: you’ll ensure the
natural flow of the text from one column to the next.

There’s one aspect where you may decide nof to recreate the source docu-
ment: the page size of your output documents. What do we mean here? Let’s
give some examples: you’'re scanning A4 pages but you create Letter output
because that format is easier to print, whereas A4 requires a manual feed. Or
you may be an attorney; you scan Letter documents that you save in the Legal
format.

That’s why Readiris allows you to define preferred paper sizes for the output
documents. Click the button "Paper Size" in the "Text Format" dialog.
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Applicable formats E xcluded formats
1: 44
2 A4 landscape AR landscape
3 Letter AR
4. etter landscape AE landscape

5 Legal
g Legal landscape

=]
TA3
2 A3 landzcape =

9: Cuztom
3
Cancel Default

Select the applicable and excluded paper sizes: the applicable paper sizes can
be used to format the recognized documents, the excluded formats won’t ever be
used. Sort the applicable paper sizes: Readiris goes through the various page
sizes in the indicated order and utilizes the first paper size that is sufficiently large
to hold the scanned document. The button "Default" re-applies the default set-
tings. (These take your Windows settings into account!)

Know that this option does not apply to HTML files - a text format designed
for the Internet that doesn’t have any page formats! Nor does it apply to PDF
files, which apply a custom fit to recreate the source document accurately.

TeEXT FORMATTING, PART 2

The other layout options are "Create Body Text" and "Retain Word and Para-
graph Formatting".
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As the icon on the right side illustrates, creating body text means you create
a non-formatted, “running” text. The text will be captured, but its formatting is
entirely ignored. Use this option when you just need to recapture a text but not its
layout.

Layout
(% Create body test

" Retain word and paragraph formatting

™ Recreate source document
v
[

Body text is also what you get when you quickly recognize a text zone by
right-clicking it and selecting the command "Copy as Text": when the recognition
is done, you’ll paste body text into your text application.

The option "Retain Word and Paragraph Formatting" represents the middle
road: the word formatting - font type, point size and typestyle - is retained
across the recognition, and so is the paragraph formatting - the tabs and the
alignment.

Don’t confuse this formatting option with “full” autoformatting: this option just
puts one paragraph after the other, it does not recreate columns or copy the
relative position of the various zones.

ExPorRTING TEXT SEVERAL TIMES

Actually, you can export the OCR results several times without repeating the
recognition! Change the text format and the formatting options under the "For-
mat" button and click the button "Recognize-Save" again. No OCR is executed
this time - unless you defined new windows or modified existing ones! Otherwise
Readiris just reformats the OCR results and saves them in the new text format or
sends them to the target application you’ve just selected.
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Format Save

The same goes for any other element you change: when you add a page to
your OCR job, only that page will be recognized. When you create a new text
zone on any page, only that zone will be recognized before the results get ex-
ported.

You could for instance recognize a 10 page document and save it in a Word
file. Then you quickly scan the abstract found on the cover page and send it by e-
mail to an impatient colleague to finally scan the appendix - a table - and save all
results in an HTML file to be posted on your company’s web site.

SavING GRAPHICS SEPARATELY

In our example, the graphic was included in the recognized document; whether
this is the case depends on the formatting option "Include Graphics". Whether it is
possible to save graphics inside the text again depends on the output mode. “Poor”
text formats such as Text (ANSI) etc. don’t store graphics!

Optionz
[ Merge lines into paragraphs

[v lnclude graphics

Still, with Readiris, you can save graphics without performing text recognition.
As Readiris generates black-and-white, greyscale and color images, you can
capture lineart graphics and photos.

How? Draw a graphic zone around the illustrations, cartoons etc. you need.
Creating graphic windows manually is done in the same way as drawing text and
table windows, simply select the "Graphic Window" tool now.

B
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Next, choose the command "Save Graphics" under the "File" menu.

m

You are prompted to specify a file name. Determine which graphic file format
you will use. Select a format that’s supported by your paint or photo retouching
software. The JPEG, TIFF and ZSoft Paintbrush (*.pcx) formats are supported.
Readiris Corporate also supports the compact format JPEG 2000 (* j2¢)!

Enable the option "Greyscale/Color" to save the graphic as a color or greyscale
graphic. When you save black-and-white graphics in the TIFF format, Group 4
compression is used. When you save greyscale and color graphics in the TIFF
format, JPEG compression is used and you can adjust the JPEG quality.

Save Graphics...

Save in: |l'f} My Pictures ﬂ i = E5-

File name: | Save

Save as type: |T|FF [*.f) j Cancel

W Greysca Zsoft Paintbrush [*.pox)

JPEG [*jpa] L )—

least best
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To send a graphic to the clipboard rather than save an image file, right-click
your mouse over a graphic window and select the command "Copy as Graphic":
the graphic zone under the mouse pointer is ready to be pasted!

source document, including its formatting,

Magnifving Glass

Wiew
Window

Copyright Inage Rest

SaviNg CoLORED BACKGROUNDS

With Readiris Corporate, you can also save the background inside the recog-
nized documents! The option "Add Image As Page Background" places the
scanned image as page background under the recognized text; this feature is
supported for HTML, RTF, Word (*.doc) and WordML (*.xml) output. (When
you generate PDF files, you can produce the same effect by selecting the format
"PDF Text-Image".)
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It goes without saying that this option increases the file size of your recog-
nized documents substantially as this option adds the scanned image with all its
detail to the document output in the background. A//its detail? Not really: as also
holds for PDF “‘text-image™ output, the pixels of the recognized text are erased to
create a legible document. Displaying recognized text in black on top of black
character bitmaps would give you text with a heavy shadow... (The sample im-
age BACKGROUND.JPG illustrates how it works.)

Laypout
(™ Create body text

" Retain word and paragraph formatting

I
Wl TRED

K

* Recreate source document
[
I

[v &dd image az page backaground
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0§ Microsoft Word

! Fle Edit Yiew Insert Format  Tools  Table  MWindow  Help
INEHRISISRIFE| LB S - Ay |51 9 100% - @) | JdRead
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de deurbekleding en de middenconzole. Onder

gefieel motor-versnellingsbak, dat ook 11 kilo
lichter is, dankzij onder andere een luchtfiterbe-
huizing in koolstofvezel en een nieuw e witlaatljn.

Aan het verminderen wan het niet-opgehangen
gewicht werd hijzondere aandacht besteed. Ook
dat liep niet van een leien dakje gezien de grotere
bandenmadt (de velgdiameter ging van 18 naar
19 duim} en het remsysteem, dat worzien moest

an uit lexan bestaat zit et

licht zijn omdat ze uit een mengeling van kool stof
en ceramisk bestaan. Daaraan mag u nog fet
Qebirik van ttanium woar de ophiangings veren en
de wiel bouten toevoegen, waardoor op deze
strateqische onderdelen ook nog eens 4 kilogram
werd bespaard. Dat maakt dat de Challenge
Stradale in totaal 11 0 kilo minder weegt, met een
rijklaar gewicht wan 1.280 in plagts van 1.390
Kilogram (zonder inzittenden).

lagtcollector en -kanalen), de variabele distributie
aangepast (atere shiting van de inlaatkleppen)
en een niewwe utlaatlin gemonteerd die minder
tegendruk biedt. De testhank bewestigt dat het
wermogen stijgt wvan 400 naar 425 pk bij hetzelfde
toeremtal  wan  #500 toeren, terwijl  de
matoringenieurs beweren dat ook een soot licht
turbo-effect optreedt door de dynamis
inlaat bij hoge snelh
magen bij 300kmih

ufing uan de gerobo-

ziin op circutgebruik. De oplossing werd hier KRACHTIGER liseerde zeswversnellingsbak werd opnieuw be-
agehoden door Bremho, in de vorm wan weli Dok de ialisten tin et bi de keken, waarkij de atomaatstand werd wegge-
immense  composietschijven (380 bj 34  pakken bljven ziten.  Ze  hebben de  jgren en de schakelid in racestand werd ingekott

compressieverhouding werhoogd wan 1131 naar
11,211, de inlaat gewijzigd fuieuw & smoorkleppen
die  minder  luchtweerstand  vermorzaken
werheterde in- :

milimeter wooraan, 340 bij 34 millimeter ach-
teraan) en indrukwekkende vaste zadels met zes
Zuigers waoraan en wier achteraan, die ook al erg

ftot 150 millis econde ).
ok het chassis werd grondig onder handen
erden harder (25 procent

Readiris also offers a less drastic and more compact alternative: the option
"Retain Colors of Background" maintains the spot colors on the page across the
recognition. (This option implies that you retain the colors of the text.)

Optionz
[v Merge lines into paragraphs

v Include graphics
v

Paper size...

[v Retain colors of background

You’ll get one uniform background color - if there is one in the source docu-
ment - per paragraph. This again applies to HTML, Word and WordML docu-
ments. The details of, say, a full-page photograph in the background are nof main-
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tained this time, the spot color of a text frame is. (Recognize the sample image
COLORS.JPG to give it a try...)

4 colors - Microsoft Word

I Fle Edit Miew Insert Formak  Tools  Table  Window  Help
P[]0 ) s - |[FE] BT S ) cese |
[ R T T T T S S S - B S S S S R SR

Group 5 Standard Unites E-Mail and Fax

here fax and e-mail

really differ is in their
respective levels of security
and reliahility. Fax a5 a point-
to-point systern s less wul-
neratle to third-party inter-
ference than e-mail trans-
ported over the public Intemet
Cn the other hand, email is
usually  delivered to  a

The &5 Forum was formed
in order to develop a new
integrated messaging  stan-
dard that handles any data file
by itself or in cormpound farm
and is able to cater to fure
unified messaging needs. The
G3 protocol has  been
designed to seamlessly inte-
grate  with Group 3 fax,

TAKING GRAPHICS TO THE HILT

inbound and outhound mes-
sages together with trans-
mission details.

The G5 messaging spec-
ification is based on Multi-
purpose Intemet Mail Exten-
sions (MIME). The standard
provides for fransmission and
identification of any file type
that's registered with the

Readiris Corporate offers other advanced options for the graphics. You’ll find
these under the button "Advanced" of the "Text Format" command.

These settings also apply to a//graphics - the graphic zones included in recog-

nized documents and the page image you place above the text in an “image-text”
Adobe Acrobat PDF file!
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[ Black-and-white graphics

* Retain scan resolution
" Reduce resalution to; dpi

JPEG quality

least best

-

Ok, | Cancel

Determine the color mode: save your graphics in color-greyscale or as black-
and-white images. Select the resolution of the images in the recognized docu-
ments: maintain the scan resolution or reduce it. (You cannot increasethe resolu-
tion in this way.) When the recognized documents get posted on a web site as
HTML files, you’ll undoubtedly want to reduce the graphics to screen resolution.
Hence, for HTML files, the graphics are by default reduced to 72 dpi. (You can
fill out a higher value manually.) Finally, you can select the JPEG quality. JPEG
images are used to store color and greyscale graphics in PDF documents, Word
and RTF documents etc.)

(The option "JPEG 2000 Compression" we already discussed: it applies JPEG
2000 compression to all graphics and images contained in PDF documents.)

These options allow you to influence the file size of your output documents
substantially! Let’s give an example: when you generate “image-text” PDF files
with bilevel graphics, you store the images in Group 4 compressed TIFF files.
Save the same scans as color images and you store JPEG files by default with a
high (0.8) quality.
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REeADING FAXES AND DEFERRED RECOGNITION

Saving images as image files opens another possibility: you can save the fi//
page and perform deferred OCR on it later on. That’s what we did with the
prescanned images of our tutorials.

Simply scan the document. Select the command "Save Full Page as Image"

under the "File" menu to save a single page. You’ll be prompted to save the entire
page as a PDF, JPEG, JPEG 2000 (*.j2¢), TIFF or ZSoft Paintbrush (*.pcx) file.

Save Full Page as Image. ..

save All Pages as Image. .. k

Select the command "Save All Pages as Image" to save a multipage docu-
ment. Two file formats are available here: PDF and multipage TIFF.

You can now select the disk as image source and open the image file with the
"Open" button (or with the corresponding command under the "Process" menu).
(If you use the "Open" command under the "File" menu, you don’t even have to
update the image source.)

As color, greyscale and black-and-white images are supported on an equal
basis, Readiris opens Adobe Acrobat PDF documents, DCX fax images (a
multipage version of the Paintbrush format), DjVu images (*.djv, *.djvu), JPEG
images, JPEG 2000 images (*.j2¢, *.jp2). PNG images, TIFF images
(uncompressed, LZW, PackBits, Group 3, Group 4 and JPEG compressed),
multipage TIFF images, Windows bitmaps (*.bmp) and ZSoft Paintbrush images
(*.pex).

This capability is particularly useful to convert your faxes into editable text
files! Readiris uses extra intelligence when it comes to reading faxes: the soft-
ware detects the typical fax resolutions - 100 x 200 dpi (“normal quality™), 200 x
200 dpi (“fine quality™) and 200 x 400 dpi (“superfine quality”) - and “prepro-
cesses” these images automatically to ensure optimal OCR results.

Nevertheless, it’s still a good idea to ask your correspondents to send faxes
with the “fine” quality - those faxes will yield better OCR results.
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Don’t forget that you can right-click on images in the Windows Explorer and
select the command "Recognize" from the "Context" menu to open images! Al-
ternatively, you can use “drag and drop™: drop image files from the Windows
Explorer onto the image zone or icon of Readiris and they are promptly opened.

REcoGNIzING DoCcUMENT BATCHES

Readiris Corporate is much more powerful when it comes to recognizing
prescanned images: you can recognize entire document batches automatically
and you can establish a watched folder. Let’s study this in detail!

Batch OCR executes the recognition on all prescanned images in a specific
folder. You could for instance scan by day and read by night... Acquire all docu-
ments to be recognized; when you’re done, run the batch OCR and leave your
PC to it. When you return the next day, all your documents have been recog-
nized!

The recognized documents get the same file name as the image files. The file
extension obviously depends on the selected output format: image file 001. TIF
gets converted into 001.DOC when Word is the selected output format.
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Batch OCR

Select image folder
|C:"\M}I Dacuments Browse...

Select texst folder

|C:'\I‘v1_l,l Documents Browsee...

[ Process subfolders

[ Ovenarite test files Test Format...

[ Delete zcans after recognition

(] 4 Cancel Help
| |

Select the image and the text folder. The text folder can be different from the
image folder - but doesn’t have to! When the image folder is identical to the
output folder, you’ll find the text documents alongside the scans (unless you en-
able the option "Delete Scans after Recognition")!

The option "Process Subfolders" determines whether the subfolders of the
image folder will be processed as well. Doing so makes sense when the prescanned
documents are placed in specific subfolders. You may for instance have a folder
named "2-18-2005" that indicates the date and subfolders "1", "2" etc. that contain
the actual documents.

If enabled, this option triggers the processing of a//subfolders; you cannot limit
the OCR to (a) specific subfolder(s). When the text folder differs from the image
folder, the subfolders get recreated, “mirrored” in the output folder!

Click "OK" to execute. No further effort is required to convert the documents:

the recognition process is entirely automatic. (Interactive learning does not apply
here.)
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Furthermore, you are limited to the “external” text formats. The OCR results
are saved on disk. Sending the reading results directly to a target application,
sending them by e-mail or opening them automatically after the recognition sim-
ply doesn’t make any sense when the OCR gets executed on an “unattended”
PC. But all other OCR options - the current document language, font type etc. -
apply: be sure to enable the proper options before you trigger the recognition!

Batch OCR comes with some advanced features. The option "Overwrite Text
Files" determines whether the OCR process can replace previous recognition
results. Disable this option when you add new image files to a folder that contains
images that have been processed previously. (Otherwise your image files would
be re-recognized when you process the folder a second time...)

The option "Delete Images after Recognition" determines whether the image
files will be deleted after the recognition. In other words, Readiris can “clean up”
your image folder for you!

Enable this option when you exclusively store-archive the recognized docu-
ments, discarding the “temporary” image files. Disable this option when you save
both the scans and the recognized documents. (We repeat that Readiris gener-
ates PDF documents of the type “image-text™: this output format saves the scanned
image andthe recognized document in a single file!)

EstaBLISHING A WATCHED FOLDER

The use of a “watched folder” is largely similar to the operation of batch
OCR. The major difference is that, this time, the user does not trigger the recog-
nition. On the contrary, Readiris systematically executes the recognition on any
image file that gets dropped in a specific folder. You can leave the OCR software
running day after day... Acquire new documents and they will be recognized
promptly.
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Watched Folder,

Select image folder

|E:\My Documents Browse...

Select text folder

|I::\I'-1_I,I Documents Browsze...

4.

[ Process subfolders Text Format...

0k | Cancel | Help ‘

Click "OK" to activate the “supervision” of the watched folder and Readiris
processes the images progressively as they get created-placed in the watched
folder. Click "Stop" to interrupt the supervision.

Waiched Folder,

Wakching Folder C:iMy Documents

Stop

Waiched Folder,

Processing file CiiMy Documents sanmple if
Stop

As is the case with batch OCR, Readiris processes the images of all sup-
ported file formats. You cannot limit the OCR to a specific graphic format: Readiris
processes the images of all supported file formats. (Any files with another file
format are simply ignored.)
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ORGANIZING BATCHES

None of this means that the (pre)scanned pages you scan are by necessity
processed blindly, in a straightforward way. On the contrary, Readiris Corporate
comes with sophisticated routines that allow to process the scanned batches in-
telligently. Go to the command "Document Processing" on the "Document Type"
button (or under the "Settings" menu) to discover how it all works.

\_ ..............

e v Texk Pages
Business Cards

Cpl Mulkiple Business Cards in a Single Scan

]

Document Processing. ..
SCanre

Document separation

" Mo document separation

¥ Detect blank pages

|ndexing
" Mo batch and document index

{* Read bar codes on pages after blank cover page

[~ Duplex scanning

Cancel

Blank cover pages can be inserted between the pages to separatethe docu-
ments. A “blank™ page is a page with hardly any black pixels - black borders
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excluded. The page toolbar highlights cover pages. the document panel marks
them.

Page | Cover page | Bar code | Irnage source Sican kime

1 wes Ci\Documents an.., 048
- ‘ 546  CDocuments an...  1.27

You can also segment a stream of scanned images manually: select any page
- blank or not - in the page toolbar, right-click it and enable the option "Cover
Page" from the "Context" menu. (Know that the contents of a cover page are
lost: cover pages serve as separator but are not read!)

Exclude Page 1

Delete Page 1

Breaking up the various documents in a stream of scanned pages is the first
step. Indexing them accurately is the next step. Bar code reading is applied to
this end. All bar codes that occur on a page that follows a blank cover page get
read automatically‘ (To give it a try, recognize the sample image BATCH.TIF.)

o et ‘3‘:
&ng%_

He Fiiaes

LA
i f i

L

i

The option "Duplex Scanning" indicates that you’re scanning the front and
rear sides of documents. The rear sides will obviously be ignored to detect a bar
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code on the next page: the next page becomes the next ffontimage, not the next
image!
The Readiris interface is helpful in other ways when you start processing

document batches: the document panel and the tooltips on the page icons indicate
the value of the recognized bar codes!

~

Include page  wes
Image source My Documentsibatch, kif
Scan time 1.04
2R, Eirne
Resolution 300 dpi
Width 2245 pixels
Height 2841 pixels
Lineskew -
Raokation
Page | Cover page | Bar code Cower page _
1 vyes Bar code 1 TEST
5 OTRONSAERT Bar code 2 12345675590
A

The bar code reading results are saved in the XML index, not in the recog-
nized document!

When you process batches manually, the option "Create One File per Docu-
ment" in the "Save" dialog saves separated documents, not complete batches.

(This only works when you create external files, not when you send the output
directly to a target application.)
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File name: |I:|at|:h
Save as type: |Hich Text Farmat j Cancel

[¥ Open after saving

[~ Send by e-mail
[ Create ane file per page

|v Create one file per document
[batch_1, batch_2...]

REecocNIzING TABLES

So far, we’ve recognized texts and faxes and we’ve saved graphics. Let’s
process a table now. Take a table of figures and scan it, or open the sample image
TABLES.JPG in your Readiris folder.

Actually, the image TABLES.JPG contains two tables, and that’s no coinci-
dence! The page analysis zones them as table windows, and Readiris will recon-
struct them for you by recreating the tables cell by cell in your spreadsheet or by
inserting a table object inside your wordprocessor files.

Let’s explore the different solutions, starting with the “gridded” or “framed”
table - it has borders around the cells.
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%t Readiris
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Register  Help

z‘ OCR Wizard

Scanning
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Source
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Scanner

- Recognition

Recognize
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. Save
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Learn

4

Farmat

Reading Tables

Readiris recognizes tabular data and recreates them cell by cell in worksheets
or as table objects inside wordprocessor files.

To insert tables as table objects, you must retain the word and paragraph formatting or recreate the
source document; see the “Format” button on the main toolbar.

The page analysis detects *“gridded” and “ungridded” tables. “Gridded" or “framed™ tables have
borders around the cells - as does the example below. The borders of the table cells get recreated.

Performance test optical media

CD-ROM Average access CPU Video clip | Sequential
Digital Versatile Disk time (msec} utilization (%) playbacks read 16 KB
(frames (K bps)
dropped)
CD-ROM 4x speed 442 4.2 10 8 612
CD-ROM 12x speed 137 20.9 5 4 1,586
CD-ROM 24x speed 80 58.2 g 2 2,258
CD-ROM 32x speed 60 2.1 - - 2,987
DVD 58 78.9 - - 3,143
Tested on 333 MHz Pentium IT PC with 64 MB RAM and 4 GB SCSI HD

“Ungridded” tables don’t have any borders around the cells. When the columns of ungridded
tables are too widely spaced, the page analysis may not detect a table window to avoid confusion
with columnized text blocks.

When your tables exclusively contain numeric characters, enable the numeric reading mode with
the “Language” button on the main toolbar for increased accuracy.

s ER

IE]

Page | Image source [ Scantime | OCRtme | Resolution | Width | Height | Lineskew | Rotation

B! CiProgramFies.. 6.7 2 300 2002 2517

AR

Run the recognition with the layout option "Retain Word and Paragraph For-
matting" or "Recreate Source Document" enabled and the table gets recreated.
Open your wordprocessor to have a look at the result: the cells and the borders
were recreated by Readiris one by one! (You could obviously have included the
text paragraphs in the text file as well.)
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I} table - Microsoft Word ;||§||z|
i File Edt Wew Insert Format  Tools  Table ‘Window Help Type a guastion for help [« %
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= Performance test optical media

~ CD-ROM Average access CFU Wideo clip Sequential
= Dugital Versahle Disk fume (msec) uhilization (%) playbacks read 16 KB
o (frames (K bps)

. dropped)

- CD-ROM 4x speed 442 4.2 10 3 ¥

= CD-ROM 12x speed 137 0.9 5 4 1,586

) CD-ROM 24x speed 20 58.2 3 2 2,258

N CD-ROM 32x speed 60 721 - - 2,987 o
- DVD 8 759 - 3,143

N Tested on 333 MHz Pentium 11 PC with 64 MB RAM and 4 GB 5C5I HD

Now the “ungridded” example - it has no borders around the cells. Note that
the page analysis nevertheless detects the table!
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(| Readiris

Fle Edit Settings ¥iew Process Lleam Register Help

OCR Wizard

“Ungridded” tables don’t have any borders around the cells. When the columns of ungridded
tables are too widely spaced, the page analysis may not detect a table window to avoid confusion
with columnized text blocks.

When your lables exclusively contain numeric characters, enable the numeric reading mode with
the “Language” button on the main toolbar for increased accuracy.

Source
2y &
st 123.985 69 3137 2395
=i 987.745 129 24 5583
Scanner 19 149 915 91.54
287.410 49 526 9,812
Recognition 429.000 0 17 17.42
499,123 149 28 1129 |

Recognize
. save

Finally, you can send your tables of figures directly to Microsoft Excel by selecting the spreadsheet
as target application - refer to the “Format™ button on the main toolbar.

| || e

Copyright Image Recognition Integrated Systems.
Web site: http://www.irislink.com

L
English
L
Learn
L &

Format

E @

Page | Image source Scan kime | OCR time: Resolution Height | Lineskew | Rotation
1 ciProgramFiles... 6,71 - 300 2092 2517

AR

For optimal OCR accuracy, you should limit recognition to the numeric sym-
bols with the "Language" button. (The numeric mode is not strictly numeric, it
includes the symbols “07 to “97, “+7, “*” /" “%”, *” (comma), “.” (dot), “(",
€7, <7 =, 087, L7, ¥ and the “€7 symbol.)
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| Mumeric

[v Mumeric

Cancel
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As you can only do this when the table doesn’t contain any alphabetic symbols
- otherwise the text portions won’t be recognized correctly - we can activate the
numeric mode now but couldn’t do it for the first table.

This time, we will send the OCR result directly to the spreadsheet Microsoft
Excel, so we select Excel as target application under the "Format" button.

Output
* Sendto

(" Extemnal file
v
&
Layout
(" Create body text

{* PFetain word and paragraph fg
~

-
-

Microzoft Excel

[

Adobe Acrobat / Reader - Image-Text
Adobe Acrobat / Reader - Text
Adobe Acrobat / Reader - Text-Image
Clipboard
Clipboard Microsoft Excel
Corel ‘WordPerfect
HTML editor

1

Microsoft Internet Explarer
Microsoft “Word 2003 M ordkdL)

Microzaft Wwiord 97 /4 2000 / 2002 / 2003 (RTF)
Metzcape

OpenOffice. arg 'wiiter 1.0, 1.1

SoftwareB02 Pro PC Suite

Sun StarQffice 6.0

Sun StarQffice 7.0

WWeb browser

‘WordPad

Ead
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The spreadsheet is started up automatically and the result looks like this: the
typical table structure with rows and columns is recreated, and you are immedi-
ately ready to process the data.

Microsoft Excel - Tahle

E‘_"l File Edit  Wew Insert Formak  Tools  Daka  Wind

NS 39 @ @ - 1
=3 - &
A | B | ¢ | D | E |

1 1238985 as9 N7 2385

2 937 745 129 24 0583

3 19 149 =NE= 91.54

4 287.410 49 olb 9812

5 429 000 0 17 17.42

5] 499123 149 28 1129

7

You may come across “ungridded” tables the page analysis does not detect as
table zones because the columns are too widely spaced - Readiris tries to avoid
confusion with columnized text blocks. To create a table window manually, click
on the "Table Window" tool in the image toolbar and proceed as usual; the button’s
tooltip again indicates the number of table windows.

a

REcoGNIZING HANDWRITTEN TEXT

|Draw kable window: III|

We’ve recognized scanned documents, tables, faxes, snapshots taken with a
digital camera, we’ve saved graphics and we’ve converted PDF documents.
Readiris adds yet another reading capability: the recognition of handwritten texts.

Actually, we should say handprinted text, not handwritten text! Hand writingis
used to describe continuous, “cursive” handwritten text. The symbols within a
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word or character string touch, it is impossible to say where one symbol ends and
another starts. With handprinting, the “block letters” are separated and the rec-
ognition software has an easier job to isolate the individual characters.

r ’ »

021 -04%os 369 -2

It takes highly specialized software - “ICR” or “Intelligent Character Recog-
nition” software - to recognize handprinted symbols. I.R.I.S.” powerful ICR tech-
nology is based on more than one million writing samples! Readiris supports all
natural writing styles - American or European. No imposed style is required.

Handprinting recognition is limited to the numerals (0-9), the uppercase letters
(A-Z) and the punctuation symbols “,”” (comma), “.” (dot) and “-” (hyphen).

Where less than optimal reading results are obtained, you can adapt your
writing style and use I.R.1.S.” optimized writing form. Consult the on-line help of
Readiris to discover the writing rules. A few simple tips can teach you why sub-
stitutions occur and how to avoid them. The blank I.R.I.S. writing form serves as
a full-page “template™ on which the block letters get filled out regularly spaced
and in the right size! You can find the empty form on the Readiris CD-ROM for
reprinting and editing.
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E? Readiris help

& AR
Hide Back Home Frint  Options
A
Lontents Ilﬂde” ] ﬁeamh] Handwriting form and handwriting rules
welcorne to the Readiris help . .
@ Introducing OCR Where less than optimal reading results are
@ Recognizing Docurnents obtained, you can use 1L.R.LS. optimized writing
= .
ml Recognizing Handwritten Text form and adapt your writing style.
?] Introducing handprinting recoan
Recognizingg handIT:rintingg | s The blank [.R.1.S. writing form serves as a full-
[2] The 1.R.1.5. handprinting form page “template” on which the block letters are
Handwriting rules filled out regularly spaced and in the right size!
Recognizing Business Cards
How ta..7?
Reference Information
Software Versions and Options
Product Reqgistration
Product Support . . -
LRLS Tip: vou can find the empty I.R.I.S. writing form
T an the Readiris CD-ROM for reprinting (in
Adobe Acrobat PDF format) and possible editing
{in Waord (*.doc) format), Print the form in color
and fill it aut. Or print it in black-and-white and
place it as a “guide” under the paper vou're
writing an.
« A few simple rules can teach you why
substitutions occur and how to avoid them,
The writing is in the pen!
Use a sufficiently thick ballpoint. Thin ballpoints
may not provide acceptable images: zones which
aren’t sufficiently dark may not get detected.
Black pens yield better results than blue pens.
v

So now we know how we can take machine-legible handwritten notes during
a meeting. How can we proceed to recognize these notes afterwards with
Readiris? Draw a handprinting window around the handprinted text and execute
the recognition. (You can give it a try with the sample image
HANDPRINTING.TIF!)
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|Draw handprinking window: EI|

#|

The document characteristics - language, font type and character pitch - do
not apply to handprinting. You’re limited to a basic English - or should we say
“Latin”? - character set of (uppercase) block letters. Nor does interactive learn-
ing apply: learning does not make sense in an environment where everybody has
a particular handwriting style. (As indicated, the ICR technology is based on
more than one million writing samples...)

| Readiris
Fille Edit Settings View

Process Learn Register Help

fiin
zg.. b L3
OCR Wizard ]
o E
W Scanning MEETING o F oo 2004 @
gs:an @
= ;{E) Asenon !
£ - — v
LDocument Type bi & Cwvs 5 LRhTE ST ©kbDC <
L Opfiu;r{s ﬁ
S SHIPHRENT WAS WEEK FARLY i=1
ﬁ Recognition @
| Reconze CHLL CL:ENT ow CEFLL PHONE@I
g ew 32 4o 45 43 £ ]
English "
L o , =
Learn [ H E CK Welh 51 TE
Ff;;;gt Wkl I RS Lt MWK EOHM

Scan time | OCR time | Resolution | Width Lineskew Rotation

2|~ % &
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READING BARS AND SPACES

And Readiris reads bar codes too...! Bar codes that figure in scanned images
can be read and included as recognized data inside the output documents.

Bar codes are composed of parallel bars and spaces between them. Pre-
defined combinations of bars and spaces represent specific characters. There
are several bar code standards or “symbologies”. All widespread bar code sym-
bologies are supported.

Only laserprinted and inket prlnted bar codes have sufficient quality. Exclude
matrix printed bar codes: they do not produce sufficient contrast and their resolu-
tion is mostly limited to 60 dpi! Readiris recognizes well contrasted bar codes
best; black bars on a white background yield the best results. Most bar code
types require a “quiet zone™ around the actual bar code. Bar codes don’t render
partial results; a missing start or stop character or an incorrect check digit always
lead to a misread, a zero result!

it ﬁ!. ”'i

Jubt
AR
I Ii i{i f

I‘ l |’ ' .

Draw a bar code window around each bar code - the page analysis does not
detect them - and execute the recognition. The bar codes are read and included
in the text output. You can also right-click a bar code zone and select the com-
mand "Copy As Data" from the "Context" menu; the bar code is read and sent to
the clipboard... (The check characters of some bar code standards are verified

but stripped from the reading results.) The sample image BARCODE.TIF illus-
trates how it works.
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ReaDING BusiNEss CARDS

We’ve recognized scanned documents, tables, faxes, snapshots taken with a
digital camera, we’ve saved graphics and we’ve converted PDF documents.
Readiris Corporate adds yet another reading capability: the recognition of busi-
ness cards (“BCR” - “Business Card Reading™)!

With Readiris, you can scan your business cards, recognize them and convert
them into an address database. In this context, OCR allows to encode calling
cards without the time-consuming task of retyping them. Think of your last exhi-
bition when you came back with an entire stack of business cards and it took your
secretary two days to encode them!

The card’s data is extracted automatically from the image and the recognized
data is assigned to specific database fields. Readiris extensively uses a knowl-
edge database, thus acquiring the necessary intelligence to discriminate the first
and last name, a city and its state, a telephone and a fax number etc. Each
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country has a different “style” of composing business cards; Americans com-
pose an address differently than the French do etc.

This works for up to 28 countries: North and South American business cards
and business cards from the European countries, including the Eastern-European
nations. (Optionally, you can read Asian business cards from China, Japan, Ko-
rea and Taiwan.)

The resulting data is available for export. You can save your contacts in a
structured text file - for instance as comma delimited data or in the vCard format
- to import them in any address database - for instance Microsoft Access.

Alternatively, you can send the contacts directly to your contact management
software Microsoft Outlook (Express) and to your PDA software Palm Desk-
top. Business card reading smoothly complements such applications as contact
managers, databases or even wordprocessors whose mail merge function allows
to print letters, envelopes and labels.

ScaANNING BusiNEss CARDS

How does business card reading work? For starters, the scanner must be set
up appropriately.

When business card reading is a major application - you’re, say, scanning a
great many business cards on a booth at a fair -, you can use .LR.I.S.’s dedicated
card scanner |BCR-II. Dedicated business card scanners are optimized for
scanning business cards and have many advantages over other scanner types:
they hardly take up any space on your desk, swiftly cope with calling cards of
varying paper and printing qualities and you never have to wonder about selecting
the correct card format.

Use the Twain interface of the IBCR-II to enable the automatic scanning
mode! Give the scan command once and enable the option "Scan Automatically"
in the Twain user interface.
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IBCR 11 V1.4

FPaper size:

)

Buziness card [landscape]

Buziness card [portrait)

Photo [3' % 5"
Large phota (4" x B']
Custom [2.1" = 3.5"]

20dpi ¢ 00dpi * 400dpi ¢ BOO dpi

N R R )

“

pr—— g
@ Rezolution:

HEEN .

1 Image type:
o

[ ||

-

Black-and-white [1 bit)
" Grayscale (2 bits)
¢ Trae calor [24 bits)

W Scan automatically

Language. .. Calibrate. .. Cloze

You can now insert one business card after the other: as soon as a business
card is placed in the scanner, the scanning starts...

To recognize business cards successfully, we recommend you to select a scan-
ning resolution of 400 dpi.
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Type
IR15. Buziness Card Reader ||

Scanner Model... |

Configure. . |
Contrast a
)
Brightness 0

f—

darken lighten

v Dptirize resolution for JCR
[ Scan anaother page after 10

Farmat:
AB -

Rezolution:

400 -

hite:

= second(z)

Cancel

ok
[ s

-
=

[ lIrevert

[ Digital camera

[ Process as 300 dpi

[ Smoothen color images

When you’re using a flatbed scanner, you can scan several business cards
simultancously on the scanner’s flatbed and have them segmented by the soft-
ware. The background must be black if Readiris is to extract the various business
cards. There’s a very easy way of accomplishing that: scan your cards with the

lid open!
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Select the option "Multiple Business Cards in a Single Scan" with the "Docu-
ment Type" button on the main toolbar (or with the command "Document Type"
under the "Settings" menu) and scan your business cards.

Document Type Text pages
\_ @ Business cards
| Diocument Type v Multiple busi ards in a single scan

With flatbed scanners, it takes a click on the "Scan" button to initiate the image
capture! (You can also select the command "Scan" from the "Process" menu to
scan an image.)

The complete page as you scanned it will never appear as such on the com-
puter screen; only the segmented business cards will.
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Format 0

If you forgot to enable the image “splitting” with the multiple card mode, click
the command "Extract Business Cards" under the "Process" menu to segment
the large image into the actual card images, throwing away the superfluous black
borders.

xkract Busine:

But whatever your scanner type may be, some options are enabled invisibly to
optimize the reading process: page deskewing and the detection of the page ori-
entation. Click the "Options" button in the main toolbar to discover them.
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g v Page Analysis

2Eaie [

foten| » Page Deskewing
v Detect Page Crientation k

It is hardly conceivable that the business cards you put on a flatbed will (all) be
perfectly straight, so let the software handle things for you... (Should you have
disabled this option by accident, there’s a "Deskew Page" button on the image
toolbar to deskew the business cards afterwards, but things may quickly become
tedious if you have to straighten every scanned business card manually!)

The same goes for the detection of the orientation: let the software handle this
for you, otherwise you’ll have to rotate business cards that were placed upside
down or at a 90° angle on the scanner flatbed. (Use the rotation buttons on the
image toolbar should you have disabled this option...)

ﬂm

IT TAKES A BusiNnEss CARD READING M oDE!

The individual card images are now properly placed in the image window.
Make sure that you enabled the card reading mode with the "Document Type"
button (or with the equivalent command under the "Settings" menu).

Cocument Tvpe  k Text pages
‘ | Multiple business cards in a single scan Q

Select the option "Business Cards" when you’re scanning the business cards
one by one, select "Multiple Business Cards in a Single Scan" to scan several
business cards simultaneously on your scanner’s flatbed. This option doesn’t just
concern the image splitting of your scans: it takes one of these two options to
recognize business cards! Select "Text Pages" to disable the business card read-
ing mode again.

| Document Type
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The button "Document Type" confirms that the business card reading mode is

enabled.
L =
| Document Type Du:u:ument Type

Enabling this special mode is necessary because special OCR routines are
then used that allow the software to assign the recognized data to specific data-
base fields - company name, e-mail addresses and web sites etc. When Readiris
recognizes the character string "John Williams", it “knows” that John is a first
name and Williams a last name. In the same way so does the system recognize
titles, such as "vice president", "engineer", cities such as Boise and Chicago, states
such as Oregon and Maryland etc.

This works for up to 28 countries: North and South American business cards
and business cards from the European countries, including the Eastern-European
nations, are supported. (Reading Chinese, Japanese, Korean and Taiwanese busi-
ness cards requires the optional module “Asian BCR add-on”. Business cards
from these Asian countries in English are supported by the “standard” Readiris
Corporate software!)

As soon as the business card reading mode is enabled, the contents of the
"Language" dropdown change! Always select the correct country.
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American English
Belgian Dutch k

Belaian French Cancel
Brazihan

Eritish Englizh
Croatian

= Czech
Danish
Dutch
Finnish
French
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Greek
Hungarian

Italian
M Luxernburagh
Maonwegiat
| English {587 Palizh
Portuguesze
Fomanian
Rusgszian
Slovak
Slovenian
Spanizh
Swedish
Taiwanese Englizh
Turkizh
Ukrainian

By selecting the business card’s “language™ in the button bar, you not only
indicate the language of the text to be recognized, you also indicate the general
layout, style of the business card. Does it have an American or British look and
feel to it? Each country has a different “style” of composing business cards,
Americans compose an address differently than the French do, Dutch ZIP codes
and telephone numbers have a different syntax than their British counterparts
etc. (Some card styles correspond to several languages: Belgium and Canada
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have two official languages, Switzerland has three! Readiris detects the selected
language automatically...)

APAGABAR

La Référence Logicielle

(’B) Helen Thomas Stéphan Mallavergne
Coordinateur Technique
Recognition Systems  intemational Sales
(408) 341-4100

(408) 341-4101 Fax
(408) 341-4135 Direct

Recognition Systems, Inc S o 10 rue Vercingétorix
1520 Dell Avenue 75680 Paris cedex 14
Campbell, CA 95008 USA Tel 01.56.54.80.22
www.handreader.com Fax 01.56.54.80.01

E-mail : smallavergne@apacabar.fr
Web : http://www.apacabar.fr

The field analysis comprises a third task: Readiris not only analyzes but also
formatsthe recognized text. The system filters all irrelevant data from a business
card, even if it plays an active role! If your business card mentions the informa-
tion "Telephone: (508) 898-42 89", the resulting output will be "5088984289" in the
telephone field. The word "telephone" is dropped, even if Readiris made good use
of it to detect the location of the telephone number. The brackets, the hyphen and
the spaces within the telephone number are also deleted.

REecocNIzING BusinEss CARDS

Process your scans as usual by clicking the "Recognize-Save" button.
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However, you are recommended to determine the output format before you
do so. Click the "Format" button to this end.

Output format business cards

o
-

Comma delimited text [*.cav)

‘ E ‘ Send to Microzoft Outlook Express

Send to Microzoft Outiook
Send to Palm Desktop
Send to Lotuz Motes
HTHL [.htrn)

Cancel
Farmat

A number of popular Personal Information Managers (“PIMS”) are supported
directly: Microsoft Outlook (Express) and your PDA software Palm Desktop.
To interface with other applications, use the “universal” formats vCard and comma
delimited data. (vCard files are swiftly imported into any vCard compliant appli-
cation: double-click a vCard file and the contacts are added to your Windows
Address Book!)

The text result looks for instance like this when you send the results directly to
Microsoft Outlook (Express).
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= Kirk Y. Matsuo - Contact
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Job title: |Pmduct Manager Business & Home/Cffice Pruc| o Display as: |Kirk . Matsuo (kirk.matsuo@sewkosj.com)‘

Company |Saiko Instruments USA Inc, | Wweb page address: |httg:[[www.se\kosmart.com ‘

1 address:. | }

File as: |Matsuo, Kirk. ¥, ~ |

Phore numbers

Business. .. | - ||4ns4321n

|
Hame... - | |
Business Fax,., | w |[408 4333261 |
Mabile... - | |

Addresses : e e L N D T :

Business. .. vi 1130 Ringwood Court

95131 San Jose California
¥ This is the mailing
address

Contacks, . Categories. .. Private |
| | |

GETTING ON-LINE HELP

This concludes our overview of Readiris. Some last-minute information may
not be included in this manual. We thus recommend you to consult the on-line
help system for additional information on Readiris.

Go to the "Help" menu to do so. The command "Help Topics" and its shortcut
key F1 allow you to navigate through the many help topics.
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Welcome to Readiris™ Help...

& lse on-line help to learn more about Readiris,
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product updates,
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The other commands of the "Help" menu tell you how to get product support,
how to contact L.LR.I.S., give direct access to the .LR.I.S. home page etc.
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